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1 About PDisp

1.1 General Program Description

PDisp Pressure Induced Displacement Analysis

PDisp calculates the displacements (and stresses if required) within a linear elastic or non-linear soil
mass, arising from uniform  normal or tangential pressure, applied to rectangular, polygonal and
circular loaded planes.

PDisp also calculates time-rate 1D consolidation for linear problems using the finite difference
approach.

The program is ideal for predicting the displacements that may arise due to the action of several
loads in a soil mass.  

PDisp is a development of (and replacement for) Vdisp.  Vdisp predicted displacements induced by
vertical loads on horizontal loaded areas only.  PDisp is capable of predicting displacements due to
both vertical and horizontal loads.

1.2 Components of the User Interface

The principal components of PDisp's user interface are the Gateway, Table Views, Graphical Input,
Plan View, Cross Sectional View, 3D Graphical Output, Text Output, toolbars, menus and input
dialogs.  Some of these are illustrated below. 
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1.3 Program Features

The main features of PDisp are summarised below.

displacements are calculated using a profile of Young's modulus with depth.  The modulus can
be constant or vary linearly with depth for each soil layer.  Non-linear stress/strain curves may
also be specified.
Displacements and stresses, and Time-rate 1D consolidation can be calculated at several
levels and at any location in plan.  The location of the displacement/stress points is defined by
means of two-dimensional orthogonal grids, by lines or by points.  The results from the grids can
be displayed graphically as contours .
Loaded areas can be defined as rectangles, circles or polygons. Pressures are applied as
vertically and/or horizontally and uniformly distributed loads to rectangular and/or circular loaded
areas. Areas can be superimposed and placed at any level.  All loads are completely flexible i.e.
no allowance is made for stiffness of the structures.
The base of the model is defined by the specification of an equivalent rigid boundary.
The ground is modelled using a series of vertical soil profiles each consisting of a number of
horizontal soil layers.  The plan distribution of the soil profiles is specified in rectangular areas
known as soil zones.  These can be superimposed allowing the development of complicated
ground models.
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No allowance is made for the effect of soil zoning on stress distribution.

1.4 Sample Files

Sample files are provided during the installation process.  These demonstrate PDisp's features.  By
default they are installed in the folder 'C:\Program Files\Oasys\PDisp n\Samples', where n indicates
the version of the program.   These files may be opened and inspected in PDisp in order to become
familiar with the typical input data that is required to create a PDisp model.

The sample files are named to indicate the features of the program that they demonstrate.

DXF files are also provided to demonstrate DXF import.

2 Methods of Analysis

2.1 General

Two methods of analysis for displacements due to loads are available in PDisp:

Boussinesq
Mindlin

The Boussinesq method has the advantage that it gives a report of stresses in the ground in addition
to displacement. In addition, it allows PDisp to perform Time-Rate consolidation.  It has the
disadvantage, however, that the results are sensitive to the spacing of the number of intermediate
displacement levels specified.  The accuracy of the result can therefore be improved by introducing
more displacement levels.  This is particularly true just beneath small loaded areas which are
carrying a significant load.  If the distribution of settlement close to the load is important then the
vertical spacing of the displacement levels should be set so that they do not exceed 25% of the size
of the loaded area.
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The Mindlin method only provides details of vertical and horizontal displacements and not stresses.
Consolidation calculations cannot be performed if this method is selected. It predicts:

vertical displacements resulting from vertical loads;
horizontal displacements resulting from vertical loads; and
vertical displacements resulting from horizontal loads.

The Mindlin method considers the effect of all the soil, above and below the load, acting elastically
when calculating vertical displacements.  It is not sensitive to the spacing of intermediate
displacement levels, unless there is a sharp gradient of stiffness, see Displacement Levels.  

2.2 Boussinesq Analysis Method

The Boussinesq analysis method calculates the stresses in the strata due to the applied loads.  The
method uses integrated forms of the well known equations derived by Boussinesq (1885).  Strains
are calculated within the strata.  Displacements are then defined by integrating vertical strains.

Stresses are calculated at points vertically beneath each intersection within a displacement grid
(see Displacement Data) and at the centre of each sub-layer, see Displacement Levels.

Vertical displacements resulting from normal loads applied on horizontal planes only are calculated
in this method. The Mindlin method may be used to calculate horizontal displacements.

2.2.1 Determination of Stresses

The vertical stress 
z
 and the sum of principal stresses 

p
 are calculated using the integrated

Boussinesq equations, with respect to x and y, over the area of a uniformly loaded rectangle.

where:

p = x + y + z

The general equations are:
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and

R = distance between the centre of the loaded area and the stress evaluation point.

z = vertical distance from the loaded area to the stress evaluation point.

p = applied pressure on loaded area

g = GLOBAL Poisson's ratio.

For this calculation it is assumed that Young's modulus and Poisson's ratio are constant throughout
the soil.  This assumption is generally considered to give a satisfactory distribution of stress, but its
validity can be doubtful where stiff strata overlie softer ones.

The pressure loads can be specified as acting at different levels.  If a stress evaluation point is above
an applied load, then no account of that load is made when determining the stresses at that point.  In
other words the displacement at a point above a loaded area is equal to the displacement at the level
of the load.

2.2.2 Strains and Displacements

The vertical strains, and thereby displacements, are calculated for each sub-layer at every stress
evaluation point.  For this calculation local values of Young's modulus and Poisson's ratio are used.

The vertical displacement, at each grid location, is calculated by summing the displacement of each
of the sub-layers from the rigid boundary up to the grid level.  For information on the location of sub-
layers, see Displacement Levels.

If a non-linear curve is specified for this stratum the program calculates the stiffness factor
appropriate to the final resulting value of strain (see  Non-linear Materials).This stiffness factor is
multiplied by the appropriate Young's modulus to obtain the final stiffness value.

2.2.2.1 Global Poisson's Ratio

The use of the Boussinesq method of solution requires the user to specify a value of global Poisson's
ratio (

g
) to enable the stress calculations to be made.  In general the choice of an average value of

g
 will not result in a significant error in the calculated displacements.  The maximum expected error

in the calculated displacements, by a poor choice of 
g
, is only about 5 to 10%.

In certain circumstances, however, the selection of 
g
 is important.  This is because although 

g
 has

no effect on the calculated value of vertical stress (
z
), it does affect the calculated mean stress 

p
 ,

which is used to derive vertical strain (
v
):
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An example of this is a short term analysis with interbedded granular and cohesive materials.  The
cohesive layer(s) will have an undrained Poisson's ratio, 

g
, whilst the granular layer will have a

drained Poisson's ratio, '.  In this case the highest relevant value of Poisson's ratio (the undrained
value) should be entered as 

g
.  Errors due to calculation of 

p
, will be less in the layers of drained

granular material, than in the layers of undrained cohesive material if the drained value had been
substituted for 

g
.

In cases such as these it is advisable to use the Mindlin method of solution, or at least to carry out
a separate run to provide a check.  This method does not generate these kind of errors.

2.2.2.2 Calculation Details

The determination of displacement for stress evaluation point 'i', at the centre of each sub-layer
proceeds as follows.

Young's modulus at 'i' is:

Where

E
t
 = Young's modulus at top of layer

E
b
 = Young's modulus at base of layer

z = Level

The vertical strain of the sub-layer is

 = Poisson's ratio of sub-layer

Where

z
 = vertical stress at the stress evaluation point

p
 = sum of the principal stresses at the stress evaluation point

For non-linear soil curves PDisp calculates the corresponding stress change at 'i' where 

i
 = 

zi
 E

i

The appropriate stiffness, modified for this stress level, is then determined by linear interpolation of
the stress values corresponding to the strain values input by the user.
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Vertical displacement within the sub-layer is then:

When E
ti
 = E

bi
, this is approximated as:

When E
ti
   E

bi
:

2.2.3 Accuracy of the Boussinesq Solution

The accuracy of the predicted settlement is influenced by the spacing of the stress evaluation points.
 Decreasing the vertical distance between the points increases accuracy.

Large changes of stress or stiffness between adjacent points will lead to a reduction of accuracy. 
Stress evaluation points should therefore also be closely spaced beneath and around localised loads
and where the variation of stiffness with depth is large.

For soils in which the Young's modulus (E) varies linearly with depth, additional sub-layers can be
generated automatically by specifying the maximum allowable ratio of E between adjacent stress
evaluation points.  This ratio controls the maximum variation of E within each sub-layer.

The default ratio value is 1.5.  It must be emphasised, however, that even with constant E the
accuracy of the Boussinesq solution is still a function of the number of sub-layers.

For further information see Young's modulus (E) and Displacement Levels.

2.3 Mindlin Analysis Method

The Mindlin method calculates relative displacements across a stratum directly from the applied
loads.  It calculates the displacements due to a vertical or horizontal load applied as a uniform stress
on a rectangular or circular area on or beneath the surface of a semi-infinite homogeneous, isotropic
and elastic half-space material. The method uses equations derived by Vaziri et al (1982) from the
work of Mindlin (1936) and does not calculate stresses.

A value for global Poisson's ratio is not required for the Mindlin calculation.

2.3.1 Mindlin and the Legacy Mindlin Method

The Legacy Mindlin method represents the Mindlin method of Pdisp versions 18.2 and earlier.  It has
the following characteristics.

Only vertical loads on horizontal planes are considered. Other load orientations are ignored.  
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No consideration is given to the influence of ground above a vertical load when calculating
settlements at points below the load.  That is, all loads are treated as though they are at the
ground surface, so that soil above the load does not contribute to resisting the settlement of
the load.  
The influence of ground above a vertical load, when calculating settlements in ground that is
above the load, is considered if the "Elastic analysis above loads" check-box is checked in
the Analysis Options dialog.  If that option is unchecked then Pdisp will assume that all points
above the load settle by the same amount as those at the level of the load.
Horizontal displacements resulting from vertical loads on horizontal planes are not calculated.

If the Mindlin method is chosen without the Legacy Mindlin option, then the most recently
implemented Mindlin method of Pdisp versions 19.0 and later will be invoked.  This has the following
characteristics that supplement those of the Legacy Mindlin method.

Both vertical and horizontal displacements are calculated resulting from normal and tangential
loads on vertical and horizontal planes.
Consideration is given to the influence of ground above a load acting on horizontal plane when
calculating settlements at points below the load, so soil above the load contributes to resisting
the settlement of the load.  However, this can be changed by the user.
Displacements "behind" horizontal loads are calculated assuming elastic soil behind the load. 

                                                                 

  Table  1

  Summary of Mindl in Methods

Legacy

Mindlin

New Mindlin

without

correc t ion fac tor

(in Pdisp 19.0)

New Mindlin 

Soil above load cons idered to

dampen displacements  below it

X

Original correc t ion fac tor for

heave in soft  soils  above the

load

X

New correc t ion fac tor for heave

in soft  soils  above the load

X X

Vert ical (normal) loads on

horizontal planes

Vert ical (tangent ial) loads on

vert ical planes

X

Horizontal (normal) loads on

vert ical planes

X

Horizontal (tangent ial) loads on

horizontal planes

X
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2.3.2 Settlement above the Load

Pdisp allows computation of settlement by several different methods.  In particular, for the Mindlin
methods, alternative assumptions can be made about the effect of the ground above a subsurface
load. 

These methods are believed to be reasonably good for computation of elastic settlements beneath a
load, provided that the stiffness of the ground is wither constant or generally increasing with depth.

NOTE: These methods are not technically “correct”, but are proposed to find a formulation that gives

reasonable results.

Settlement above the load

In Figure 1 the blue solid curve represents settlements computed for a subsurface load in a uniform
material.  Settlements above the load are derived in Pdisp in one of 2 ways:

A)Assume the settlement is the same as at the level of the load – line AB in Figure 1.
B)Assume the Mindlin distribution above the level of the load – line AC in Figure 1.

If the load is deep in the ground, method A may seriously overestimate the settlements at higher
levels above the load.  Method B might be reasonably OK in uniform material.

The red curve in Figure 1 represents a situation in which the soil below the load is about 5 times
stiffer than it was for the blue line, but the soil above the load is unchanged.  For this situation, a
“correct” solution for settlement above the load would probably look something like curve A'D'.  At
present  GSPR uses method B above in Pdisp, so adopts curve A'C'.  It can be seen that this can
give the unreasonable result that points above the load actually heave.  

The problem is that A'C' relates to the settlement that would occur at level A if the material below A
were the same as that above (ie point A).  This curve needs to be corrected to relate to the
settlement actually computed at level A (ie point A').
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Soil 1

Soil 2

Rigid base

Vertical load

Soil 3 etc

Settlement

D
e
p
th

  
z MRB

Mz

A

BC

A’

B’C’ D’

Soil 1

Soil 2

Rigid base

Vertical load

Soil 3 etc

Settlement

D
e
p
th

  
z MRB

Mz

A

BC

A’

B’C’ D’

To correct the settlements above the load, either of the following two correction factors are applied:

Notation: w(Zi)  – vertical displacement at level Zi ,

   M(Zi) – Mindlin integral at level Zi
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Zn – level of first displacement point immediately above the load

M(Zn) – Reference Mindlin integral for use in equation (2) below. This is actually, the Mindlin integral

at level Zn

Legacy Correction Factor New Correction Factor

For Zi > Zn( > ZL),

w(Zi) = w(Zi-1)*M(Zi)/M(Zi-1)                                 

    ---(1)

For location Zn (displacement level immediately

above load),
w(Zn) = w(ZL)*M(Zn)/M(Zn) = w(ZL)

For the other points above the load,
w(Zn+1) = w(Zn)*M(Zn+1)/M(Zn)  = w(ZL)*M(Zn+1)/

M(Zn)

w(Zn+2) = w(Zn+1)*M(Zn+2)/M(Zn+1) = w(ZL)*M(Zn

+2)/M(Zn)

Thus, it can be seen that, equation (1) simplifies
to, 
w(Zi) = w(ZL)*M(Zi)/M(Zn) , where Zi > Zn               

  ---(2)

It should be noted that the Reference Mindlin
integral is evaluated at the location of the
displacement level immediately above the load(i.e.
Zn), but NOT at the load(i.e. ZL). As a result, 

w(Zn) is NOT the actual displacement at the level

Zn, but the displacement at the load level, ZL.

Thus, the heave in the zone between the levels Zn
and ZL is not taken into account. Also, these

Mindlin integrals take into account the soil above
the load, unlike those used in the evaluation of
settlements up to the level of the load.

With correction factor applied, the settlement
is calculated up to the level of load in the
same way as the Legacy Mindlin method,
BUT here the Mindlin integrals take into
account the soil above the load. 

For Zi > Zn( > ZL),

w(Zi) = w(Zi-1) + [{M(Zi)-M(Zi-1)}/Ei]*w(ZL)

                            [{M(Zi)-M(ZRBL)}/Ei] 

where Ei is the Young’s modulus in the sub-

layer immediately below Zi.

For location Zn,

w(Zn) = w(ZL) + [{M(Zn)-M(ZL)}/En]*w(ZL)

                            [{M(Zn)-M(ZRBL)}/En] 

Note: For points away from the load, the
correction factor i.e.

{M(Zi)-M(ZRBL)}/Ei*w(ZL) 

is evaluated by considering the load to act at

the same plan location of the point under

consideration.

2.3.3 Settlement below the Load

The following discussion applies to only the new Mindlin method.

The settlement below the level of the load is also affected by the presence of soil above the load.  In
Pdisp, this effect may be 
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(1) included as if the soil above were of the same stiffness as that below or 
(2) disregarded (i.e. the computation is as though the load were at a soil surface).  

This is applicable only for loads acting on horizontal planes. The user may choose either of these
options in Pdisp.

In GSPR, option (1) is currently used for horizontal loads on horizontal planes, and option (2) is used
for vertical loads on horizontal planes. These cannot be changed by the user.

These are also the default options for the new Mindlin method, when the user creates a new file in
the current version of Pdisp.

Note: When files created by version Pdisp 19.0 are read by this current version of Pdisp, option (1) is
used for vertical loads on horizontal planes.

2.3.4 Calculation Details

The Mindlin method does not calculate stresses, but implicitly assumes that the stresses in a given
layer are the same as they would be if the whole of the ground had the same elastic properties as
that layer.

The solution is therefore exact for a soil of constant elastic properties irrespective of layer thickness.

If the value of Young's modulus or Poisson's ratio varies with depth, then the materials should be
divided into sub-layers.

Displacements are calculated at the strata boundaries and at intermediate displacement levels when
these are specified, see Displacement Levels.

Mindlin (1936) derived equations for the displacement due to a vertical or horizontal point load applied
within a semi-infinite homogeneous, isotropic elastic half space. Vaziri et al (1982) provided
integrated forms of these equations to give horizontal and vertical displacements due to uniform
stresses applied to horizontal or vertical rectangular areas.

2.3.4.1 Vertical Displacements

The basic equation can be expressed as:

where:

M = Function of the relative distance between the load and the displacement point and Poisson's
ratio.
E = Young's modulus of the half space.

To analyse the sub-layer, the function M is first calculated at the top (M
ti
) and base (M

bi
) of the layer.
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For a layer with constant E, the relative settlement across the layer is:

Where E is assumed to vary linearly with depth, the approximation that M also varies linearly is
made:

where:

E
t
  = Young's modulus at top of layer

E
b
 = Young's modulus at base of layer

z = Level

2.3.4.2 Horizontal Displacements

There are three options available to calculate the stiffness of soil for calculating horizontal
displacements

use weighted average
use greatest stiffness
use stiffness at displacement point

Displacements "behind" horizontal loads are calculated assuming elastic soil behind the load.

Use Weighted Average

In this method, the average stiffness is calculated between the centroid of load and the displacement
point at which the horizontal displacement is required.
 
A line connecting the load and the displacement point is considered for the calculation of horizontal
displacements. This line can pass through different layers of different soil profiles associated with
different zones. Each layer has its own Young's modulus and Poisson's ratio. The average Young's
modulus and shear modulus are calculated by considering a weighting based on the length of the
line passing though each of the layers. The Poisson’s ratio to be used is then derived from the ratio
of average Young’s modulus to average shear modulus.

Let the required Young's modulus and Poison's ratio be E* and *.

The “average” E = E* = E
i
L

i
} / L

i

The “average” G = G* = G
i
L

i
}/ L

i

and G* = E*/(2(1+ *)). So * = E* / (2G*) - 1.

Where E varies with depth within a stratum, the average within the stratum is calculated by
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integration.

Use Greatest Stiffness

In this method, Pdisp takes the maximum Young’s modulus that occurs along the line connecting
the load and the displacement point.  The Poisson's ratio is set to that of the stratum where the
greatest E is found.

Use Stiffness at Displacement Point

This method should be used with caution. 

In this method the stiffness at the displacement point is used for calculating horizontal
displacements. The soil properties between the load and the displacement points are disregarded.

The horizontal displacements are calculated through soil zones. The properties of soil material for
calculating horizontal displacements are taken by it Z co-ordinate. If a point lies in a soil strata with
different top and bottom Young's modulus, the value at the point is linearly interpolated.
Intermediate points within the zone for calculating the horizontal displacement are taken in the
direction of the load.

2.3.5 Accuracy of the Mindlin Solution

The Mindlin solution is exact if the elastic properties are constant with depth.  The solution for an
individual layer with constant elastic properties is also exact. The solution for vertical loading is a
good approximation provided stiffness does not decrease significantly with depth.  For horizontal
loading the accuracy of each of the methods offered by the program is problem-dependent and
should be considered by the user. 

Sub-layers are therefore only required if the value of stiffness varies within a layer.
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The default ratio for the maximum variation of Young's modulus within the sub-layer is 1.5.  This
provides sufficient accuracy for most purposes.

2.4 1D Compression

Pdisp assumes the Boussinesq stress distributions.

For the purpose of this note uniform pressure loading of a circular area is considered, concentrating
on a point at the ground surface and at the centre of the load. Also, Poulos and Davies Eq 3.13a and
3.13b are used. 

In 1D compression, the ratio of the horizontal to vertical stress change is /(1 ).  In Boussinesq it is
(1+2 )/2, which is larger than in the 1D case.  The reason for this larger horizontal stress increase is
that the load is not transferred vertically, but spreads into the ground:

The process of spreading implies a horizontal component of stress which converges on the loaded
area, increasing the horizontal stress by more than /(1 ).  The larger increase of horizontal stress
leads to a smaller vertical strain.  The ratio of vertical strains (1D  Boussinesq) / 1D is equal to .

The Boussinesq stress distribution is strictly only correct for loading on the surface of a
homogeneous isotropic infinite half-space.  It may be thought that by loading a very large area, 1D
compression would apply at the ground surface and at the centre of the load.  But no matter how
large the loaded area, it is small compared with the “infinite” half space of the theory, so the effect on
horizontal stress still applies.  

In reality, the stress distribution is changed by the non-homogeneity of the ground, a generally
increasing stiffness with depth.  This has proportionately more effect on horizontal than on vertical
stress, although the horizontal stresses have proportionately less effect on vertical strain and
settlement.

The fundamental assumption and approximation of Pdisp is that it uses the Boussinesq stress
distribution irrespective of non-homogeneity, and even of the rigid boundary at the base.  (In this
respect, the Mindlin approach is no different.)  This approximation is reasonably good in most cases,
but its inaccuracy may vary from case to case.
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The graph below shows the settlement computed for a 4.1m thick layer with Young’s modulus
2500kPa, located beneath the centre of a large area loaded to 100kPa.  The computed settlements
are shown for various values of Poisson’s ratio.  

Users should be aware of this feature so that they can decide whether the error involved is of
concern. Finite element analysis by programs such as Oasys Safe may provide a better general
solution in cases where inaccuracy is high.  Analytical solutions for special cases might be found,
for example in Poulos & Davis.

2.5 Consolidation

Pdisp performs 1D consolidation calculations using the numerical approach. The Crank-Nicholson
finite difference method, which is implicit in time, is used to calculate the pore pressures.         
         

2.5.1 Pore Pressures

The differential equation of consolidation is given by 

where,

C
v
 - is the coefficient of consolidation

u   - is the excess pore water pressure
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t    - is the time
z   - is the depth

The finite difference approach used to solve this equation is based on a depth-time grid, where the y-
axis represents the depth and the x-axis represents the time step. Each point on the grid is a
representative of the excess pore water pressure at a particular depth and at a particular time step.

where,

            u
i,j
 - is the excess pore water pressure at ith depth position and jth time step

Crank-Nicholson Method

In this method, the differential equation for consolidation is solved by substituting the forward
2 2. However, the second

central difference is taken as the average value of the central differences at the (i,j)th and (i, j+1)th

levels.

After re-arranging the terms in the resulting equation, the generic equation for the Crank-Nicholson
method at any grid point is given by

where,
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             where,

                         ∆z - is the distance between ith and (i+1)th level

                         ∆t - is the time step 

Note: It is recommended that the condition 1/3 < r < 2 is satisfied (Abid and Pyrah) for each stratum

of a profile either by altering the number of intermediate displacement levels of a stratum or the time

step. Otherwise it may lead to discretisation errors and numerical disturbances. 

The above equation is applied at all grid points to get a system of linear equations, which takes the
form 

[A][u] = [C]

where,
           A - is the coefficient matrix, which is tridiagonal in nature
           u - is the excess pore pressure matrix
           C - is the constant matrix

In the equation above, the coefficient and constant matrices are known, so the 'u' matrix is calculated
as

[u] = [A]-1[C]

This procedure is repeated at every time step to get the values of 'u' at all grid points.

2.5.1.1 Boundary Conditions

1) The phreatic surface in an undrained material is assumed to be freely draining and hence the
excess pore pressure there is assumed to be zero.
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2) The initial excess pore pressure at a point for time step t = 0 is equal to the vertical effective
stress at the point obtained through elastic calculations.

∆u
0
 = ∆σ

v
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3) If the Rigid Boundary Level is permeable, then the pore pressure values for it are assumed to be
zero.

                      

4) If the Rigid Boundary Level is impermeable, then imaginary nodes are assumed on the other side
of the boundary, which are reflections of the immediate nodes on the top of the boundary. 
Thus,  u

i-1,j 
= u

i+1,j
 and u

i-1,j+1
 = u

i+1,j+1
. These values are substituted in the generic equation for the

boundary.
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2.5.2 Layered System

For a layered system, the pore pressure for an interface node is obtained by applying the continuity



22 PDisp Oasys Geo Suite for Windows

© Oasys Ltd. 2018

equation for flow across the interface. The final equation is shown below.

                        

where, 

            
where,

                 

                     

 

                     

                   

The user can input either k or C
v
 for a layer. Based on the value input and the consolidation method

selected. The following relations are used to get C
v
 from k or vice versa.

m
v
 method:
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C
c
 method:

            

Where,

         γ
w
 - is the unit weight of water

         σ' - is the effective stress

         C
c
 - is the compression index of the soil

2.5.3 Degree of Consolidation

Degree of Consolidation

The pore pressures that are obtained are used to calculate the degree of consolidation (U) for each
time step.

where,
           u

i
 - is the initial excess pore pressure

           u - is the excess pore pressure at the time step under consolidation

2.5.4 Settlement

 Two components of consolidation are calculated.

Primary
Secondary

2.5.4.1 Primary Consolidation

Two methods are used for the calculation of primary consolidation

1) m
v
 method

2) C
c
 method
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2.5.4.1.1  mv method

This is a linear approach. 

The primary consolidation at any node in an undrained layer is given by:

primary consolidation =  m
v
*∆σ'

v -av g
*H

where,
           m

v
 - is the coefficient of compressibility of the layer

           H - is the distance between the ith and (i+1)th levels

           ∆σ'
v -av g

 - is the average of vertical effective stress at the ith and (i+1)th levels

Example

Let 't' be the time step at which settlement is to be calculated at node '3'  shown in the image below

             

The primary consolidation at node 3 at a time step 't' is given by the sum of following

1. Primary Consolidation of  7-8     
2. Primary Consolidation of 6-7
3. Primary Consolidation of  3-4     

If the element is in a layer that is undrained and submerged, then primary consolidation at time step
't' is given by
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    settlement = U
t
 * (m

v
*∆σ'

v -av g
*H)

where,
 
            U

t
 - is the degree of consolidation at that time step of that undrained submerged layer

            m
v
 - is the coefficient of compressibility of the layer

            H - is the distance between the ith and (i+1)th levels

            ∆σ'
v -av g

 - is the average of vertical effective stress at the ith and (i+1)th levels

Applying this to the example under consideration,

Primary Consolidation of 7-8  = U
t-lay erD

 * (m
v -lay erD

*∆σ'
v -av g7-8

*H)

Primary Consolidation of 6-7  = U
t-lay erD

 * (m
v -lay erD

*∆σ'
v -av g6-7

*H)

Primary Consolidation of 3-4  = U
t-lay erB

 * (m
v -lay erB

*∆σ'
v -av g3-4

*H)

Hence, total primary consolidation at 3 at a time step 't'

     = U
t-lay erD

 * (m
v -lay erD

*∆σ'
v -av g7-8

*H) + U
t-lay erD

 * (m
v -lay erD

*∆σ'
v -av g6-7

*H) + U
t-lay erB

 * (m
v -lay erB

*∆σ'
v -

av g3-4
*H)

Total settlement at 3 at a time step 't' is given by

Total Settlement = Immediate settlement at '3' calculated using the elastic method (Mindlin/
Boussinesq) selected for the model + Total primary consolidation at '3' (explained above)

2.5.4.1.2  Cc method

This is a non-linear approach. 

The relationship between vertical strain and void ratio is given as:

where ∆H is the change in height of the layer and is the primary settlement s
c
. Hence the primary

consolidation is given as:

where,

∆H -  is the change in height of the layer
H

0
 - is the original thickness of soil layer

∆e - is the change in the void ratio between time 't' and initial condition
e

0
 - is the Initial or in situ void ratio



26 PDisp Oasys Geo Suite for Windows

© Oasys Ltd. 2018

Overconsolidated Soils

If the vertical effective stress at an instance is less than the preconsolidated stress (σ'
p
), then the soil

is said to be overconsolidated.

Consider the void ratio vs vertical effective stress plot above. Two cases arise:-

Case 1: 

If the vertical effective stress after the application of load is less than the preconsolidated stress, then
the change in void ratio is given by:

 

Case 2: 

If the vertical effective stress after the application of load is greater than the preconsolidated stress
then the change in void ratio is given by:
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where,
 
C

c
 - is the compression index of the soil

C
r
 - is the recompression index of the soil

σ'
p
 - is the preconsolidation stress or maximum past vertical effective stress

σ'
v 0

 - is the vertical (effective) overburden stress

∆σ
v
 - is the applied stress

Normally Consolidated Soils:

The change in void ratio for normally consolidated soils is given by:

In PDisp, normally consolidated soils can be modelled by entering Pre-consolidation margin as 0 or

OCR as 1.

As for m
v
 method primary consolidation is calculated only for layers that are undrained and

submerged. 

Total settlement (at time step t) = Immediate settlement calculated using the elastic method
(Mindlin/Boussinesq) selected for the model + Total primary consolidation (at time step t)

2.5.4.2 Secondary Compression

PDisp assumes that secondary compression happens after 95% of consolidation. Hence, it is
calculated for time steps at which the degree of consolidation is more than 95%. i.e. t > t

p
 .

Secondary compression is calculated as

where,

C
α
 - is the secondary compression index of the soil

e
0
 - is the initial or in situ void ratio

H
0
 - is the original thickness of soil layer

t
p
 - is the time taken to achieve 95% consolidation.

t - is the time at the current time step.
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If the m
v
 method is chosen, then input of C

αe
 is required instead of C

α
 and e

0
.

 The secondary settlement is then calculated as:

where,

C
αe

 - is the modified secondary compression index of the soil

When the degree of primary consolidation reaches 95%, secondary compression is calculated and
added to the total settlement.

3 Input Data

3.1 General

The following provides details of all the information required to run the Pdisp program.

On selection of the Pdisp program the main screen will open.

The "Welcome to Pdisp screen" will pop up next, if it is enabled by the user in the Preferences
dialog.  This allows the user to either create a new data file, to open an existing file, or to select a file
from a list of recently used files.

If the startup dialog on the program menu is disabled, the user can create a new project file via: 

File | New menu button or 
the new file icon in the Standard Toolbar.  

This will open a new "Titles" window and allows the user to proceed.

The About button allows the user to view the program details, whereas the Home Page button
opens the Pdisp home page in a browser.

3.2 Preferences

This dialog can be accessed by clicking Tools | Preferences. Preferences can be set whether a file is
opened or not.

The Preferences dialog is accessible by choosing Tools | Preferences from the program's menu. It
allows user to modify settings such as numeric format for output, show welcome screen, option for
new model wizard, print parameters and company information. These choices are stored in the
computer's registry and are therefore associated with the program rather than the data file.  All data
files will adopt the same choices.
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Numeric Format controls the output of numerical data in the Text Output. The Text Output presents
input data and results in a variety of numeric formats, the format being selected to suit the data. 
Engineering, Decimal, and Scientific formats are supported.  The numbers of significant figures or
decimal places, and the smallest value distinguished from zero, may be set by the user.  

Restore Defaults resets the Numeric Format specifications to program defaults.

A time interval may be set to save data files automatically.  Automatic saving can be disabled if
required by clearing the "Save file.." check box.

Show Welcome Screen enables or disables the display of the Welcome Screen.  The Welcome
Screen will appear on program start-up, and give the option for the user to create a new file, to open
an existing file by browsing, or to open a recently used file.
  
Company Info allows the user to change the company name and logo on the top of each page of
print out. To add a bitmap enter the full path of the file.  The bitmap will appear fitted into a space
approximately 4cm by 1cm.  The aspect ratio will be maintained. For internal Arup versions of the
program the bitmap option is not available.

Page Setup Opens the Page Setup dialog allowing the style of output  for printed text  and graphics
to be selected. 
If 'Calculation Sheet  Layout´  is  selected  the  page  is  formatted  as  a  calculation  sheet  with  details
inserted in the page header. 
If `Logo´ is selected the company logo is inserted in the top left corner of the page. 
If `Border´ is selected this gives a border but no header information. 
If `Clipped´ is  selected the output  is  clipped leaving a space for the logo.  This  has no effect  on text
output. 

3.3 Data Input

All data is input via options on the program's Data menu, or via the Gateway.

The information can be entered in any  order.   The  exception  is  that  Soil  Profiles  must  be  entered
before Soil Zones.   Once the data has been entered the program places a tick  against  that  item in
the menu list.

Graphical Input  allows the areas for rectangular or circular  load  data,  soil  zones  and  displacement
data to be drawn rather than entered as tabular input.

The Graphic  Settings option displays  a dialog that  controls  the format  and  content  of  3D Graphics
View. 

Pile-soil interaction related information can be entered only  if the "GSA raft  analysis  data"  option is
selected in the Analysis Options.
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3.3.1 Titles

The first window to appear, for entry of data into Pdisp, is the Titles  window.

This window allows entry of identification data for each program file.  The following fields are available:

Job Number allows entry of an identifying job number

Initials for entry of the user's initials

Date this field is set by the program at the date the file is saved

Job Title allows a single line for entry of the job title

Subtitle allows a single line of additional job or calculation information

Calculation Heading allows a single line for the main calculation heading

The titles are reproduced in the title block at the head of all printed information for the calculations. 
The fields should therefore be used to provide as many details as possible to identify the individual
calculation runs.

An additional field for notes has also been included to allow the entry of a detailed description of the
calculation.  This can be reproduced at the start of the data output by selection of notes using File |
Print Selection.

3.3.1.1 Titles window - Bitmaps

The box to the left of the Titles window can be used to display a picture beside the file titles.

To add a picture place an image on to the clipboard.  This must be in a RGB (Red / Green / Blue)

Bitmap format.  Select the  button to place the image in the box.  

The image is purely for use as a prompt on the screen and can not be copied into the output data. 
Care should be taken not to copy large bitmaps, which can dramatically increase the size of the file.

To remove a bitmap select the  button.

3.3.2 Units

The Units dialog is accessible via the Gateway, or by choosing Data | Units from the program's
menu. It allows the user to specify the units for entering the data and reporting the results of the
calculations. These choices are stored in, and therefore associated with, the data file.

Default options are the Système Internationale (SI) units - kN and m.  The drop down menus provide
alternative units with their respective conversion factors to metric.

Standard sets of units may be set by selecting any of the buttons: SI, kN-m, kip-ft kip-in.

Once the correct units have been selected then click 'OK' to continue.
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SI units have been used as the default standard throughout this document.

3.3.3 Analysis Options

The following data is entered to define the outline of the problem and the type of analysis to be
carried out.

General tab - for general model parameters that are relevant to both elastic and consolidation
calculations
Elastic tab - for general model parameters that are relevant to only elastic calculations
Consolidation tab - for general model parameters that are relevant to only consolidation
calculations

3.3.3.1 General

Global Poisson's Ratio for calculation of stresses (Boussinesq solution only) 

See also Global Poisson's ratio.

Maximum Allowable Ratio (Ra) between values of Young's modulus (E) at adjacent
displacement levels. The default value is 1.5.

  
See also Young's modulus (E).

An equivalent rigid boundary level i.e. the solution boundary or base of the lowest soil layer.

GSA raft analysis data enables the input of pile-soil interaction properties and pile-soil
interaction coefficients.  The pile-soil interaction data is not used in Pdisp's analyses and so
does not affect its results.  These data are included for export to Oasys GSA in order for GSA to
perform raft analysis.

Displacements at load centroids reports the displacements and stress/strain results at the
centre of the specified loaded areas.  This is in addition to the locations specified by
Displacement Data.

3.3.3.2 Elastic

Elastic enables the elastic calculations

Analysis Method

Boussinesq

This method calculates vertical displacements only.  It is applicable for settlements and
stresses resulting from vertical loads on horizontal planes. If other loads are specified, these
will be ignored by the analysis. For further details see the Boussinesq Analysis Method.

Mindlin

The Legacy method represents the Mindlin method of Vdisp versions 18.2 and earlier.  If
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the Legacy Mindlin checkbox is unchecked, then the most recently implemented Mindlin
method, of Pdisp versions 19.0 and later, will be invoked.  See Mindlin and the Legacy
Mindlin Method for a comparison of these methods.

Elastic analysis above loads reduces, with height, the settlement above loads which are
applied below ground level. It may only be switched off in the Legacy Mindlin solution, see 
Mindlin and the Legacy Mindlin Method.

If horizontal displacements are not required, then Calculate horizontal displacements
should be un-checked.  This will speed up the calculations.  This option is not applicable for
the Legacy Mindlin and Boussinesq methods since they do not predict horizontal
displacements.  

Stiffness for horizontal displacement calculations

Use weighted average

In this method, the average Young’s modulus and Poisson's ratio are calculated between the
centroid of each load and the displacement point at which the horizontal displacement is
required. For further details see Horizontal displacements.

Use greatest stiffness

In this method, the maximum Young’s modulus that occurs between the centroid of each
load and the displacement point is used for the calculations. The Poisson's ratio is set to
that of the stratum where the greatest E is found. For further details see Horizontal
displacements.

Use stiffness at displacement point

In this method, the stiffness at the displacement point is used for calculating horizontal
displacements. The soil properties between the load and the displacement points are
disregarded. This method should be used with caution.  For further details see the Horizontal
displacements.

Heave correction factor

When calculating the displacements above the load, especially when there are softer soils
over stiffer soils, correction factors are applied to the calculations to prevent excessive
displacements in the softer soil layers.There are two options to choose from - the older 
version of correction factor that was used in the legacy Mindlin solution, or the new
correction factor which is believed to be more accurate. By default, the newer option is used.
However, if the user decides to use the Legacy correction factor, he should select the
corresponding check box. See also Settlement above the load.

Effect of soil above load

When calculating the displacements below the load acting on horizontal plane, the user has
the option to ignore the effect of soil above the load in calculations - both for normal and
tangential loads. See also Mindlin and Legacy Mindlin methods and Settlement below the
load.r topic text here.
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3.3.3.3 Consolidation

Consolidation enables the consolidation calculations

Time Period over which the consolidation calculations are to be performed.
  

Time Step i.e. the interval at which the consolidation calculations are to be performed and their
results reported.

Impermeable Rigid Boundary - the boundary condition for the calculation of excess pore
water pressure.

k/Cv  input permeability or coefficient of consolidation

The ground water profile is hydrostatic.

Level of the water table 

Pressure at the phreatic surface

Unit weight of water

3.3.4 Soil Profiles

The soil profiles window allows the ground conditions to be entered.  These are modelled as a
series of ground profiles.  The profiles are entered in tabular form. 

Soil profiles are vertical columns through the ground which are separated into levels of strata.  A new
table is created for each soil profile.  Each new profile is created by selecting the next tab along the
top of the table. 

Layers must be entered in order of decreasing level.

The lateral extent of each soil profile is specified later as a soil zone.

Each soil profile requires the following data to be entered:

name of stratum
level at top of each stratum
number of intermediate displacement levels
Young's modulus
Poisson's ratio

If the consolidation option has been selected, then the following additional data items need to be
entered:

   Method : m
v
/C

c 
/None

     
   If m

v
 is selected

   m
v
 - coefficient of volume compressibility
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   C
αε

 - modified secondary compression index 

      If Cc is selected
   e

0
 - initial void ratio

   C
c
 - compression index

   C
r
 - Recompression index

   Overcons. Calc. Type :
o Pre-consolidation pressure

o Over-consolidation Ratio (OCR)

o Pre-consolidation margin

  C
α
 - secondary compression index

       If None is selected then the layer undergoes no consolidation
 

   C
v
 - coefficient of consolidation. 

   k - coefficient of permeability

Default values for the above can be set by clicking on the grey default boxes at the top of each
column and entering a value.  These values are then adopted for new layers unless reset.

The Colour field indicates the colour of the stratum of the profile when displayed in the 3D Graphical
Output.  The program will assign a default colour when creating a record if all other fields in the
record are valid. The colour can be changed by left-clicking the cell.

The column for identifying non-linear curves to individual layers of strata is only added to the table for
soil profiles once a non-linear curve has been defined.  See section for Non-linear Materials.

The pile-soil interaction property column is only available if GSA raft analysis data has been
enabled in the Analysis Options.  It allows the selection of a pile-soil interaction property to be
associated with each layer of a soil profile. The pile-soil interaction data is not used in PDisp's
analyses and so does not affect its results.  These data are included for export to Oasys GSA in
order for GSA to perform raft analysis. For further details see Pile-soil interaction using GsRaft.

3.3.4.1 Displacement Levels

Displacement levels sub-divide each layer of soil into a number of sub-layers.  For example the
specification of two intermediate displacement levels will divide the layer of soil into three sub-layers.

This process also defines the number of stress calculation points, with depth, for the Boussinesq
solution.  The stresses are calculated at the centre of each sub-layer.  

The lateral location of each calculation point is defined by the use of displacement grids, see 
Displacement Data.

3.3.4.2 Number of Displacement Levels

The number of displacement levels calculated is determined as the larger of:  

a user-specified number (N) given for each soil layer
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an automatically generated number (n) taken from the Maximum Allowable Ratio (R
a
)

between values of Young's modulus (E), see  Young's modulus (E).

The value of n is calculated by

So, for the example illustrated above, if R
a
=1.5

then 

The value of n is always taken as the next lowest integer.

The value of R
a
=1.5 is normally sufficiently accurate for most problems.

3.3.4.3 Location of Displacement Levels

If Young's modulus (E) is constant with depth then the displacement levels will be evenly spaced.  If
E increases with depth then the sub-layers are bunched around the lowest values of E in the
following way:
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z
t
 = level of top of strata layer

z
 = thickness of strata layer

j = number of sub-layer (as shown above)

l = level of sub-layer

n = n or N (See Number of Displacement Levels).

e.g

where:

e.g.

For consolidation calculations, a displacement level is added at the water level if it does not coincide
with the existing levels.

3.3.4.4 Young's Modulus (E)

The Young's modulus for the soil can be entered as a constant value or varying linearly with depth. 
Values are required for the top and base of each stratum layer.

For soils in which the Young's modulus (E) varies linearly with depth, additional sub-layers can be
generated automatically by specifying the Maximum Allowable Ratio (R

a
) of Young's modulus

between adjacent stress evaluation points.  This ratio controls the maximum variation of E within
each sub-layer.
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The Maximum Allowable Ratio (R
a
) between values of E at adjacent displacement levels is 

where:

E
t
 = Young's modulus at the top of the stratum

E
b
 = Young's modulus at the base of the stratum

The minimum value of R
a
 is 1.0.  The default value of R

a
 is 1.5.  This is normally sufficiently accurate

for most general models.  See also  Number of Displacement Levels.

3.3.5 Load Data

The following types of loads can be input.

Rectangular
Circular
Polygonal

3.3.5.1 Rectangular

If the Mindlin analysis method is chosen then rectangular loads may be applied applied vertically
and/or horizontally on horizontal and vertical planes (i.e. in both the normal and horizontal directions).

If the Boussinesq analysis method is chosen then loads may be applied only vertically on horizontal
planes (i.e. in the normal direction).

Loads can be superimposed and placed at any level.  All loads are completely flexible - no allowance
is made for stiffness of the structures.

Note : The loaded areas can be entered in tabular form (as described below). Horizontal planes with
vertical rectangular loads, without any rotation can be entered in graphical form.  For information on
entry of graphical data see  Graphical Input.

Specification of the load in the table view. Much is context sensitive so its accessibility depends on
the load shape and orientation of the loaded plane

Orientation can be either horizontal or vertical.

Centre of load is the centre-point of the load for defining its plane entered in global co-ordinates.

Angle of local x w.r.t. global X orientates the local axis. The plane can be rotated (in plan) by an
angle. The base point for the rotation is the centre of the load. The figures below illustrate the local
axis in relation to the global axis. Although the shape then remains the same, and normal loads are
unaffected, the directions of tangential loads will be affected.  The angle of local x w.r.t. global X is
zero for loads parallel to the Cartesian co-ordinate system.  Positive angles are counter-clockwise.



38 PDisp Oasys Geo Suite for Windows

© Oasys Ltd. 2018

Width and Depth of a rectangular load are measured in the local x and local y directions
respectively.

Load value specifies the load intensity to be applied to the plane.  Depending on the analysis
methods, loads can be either normal or tangential to the loading plane. Tangential loads are specified
with respect to the local axis of the loaded plane (i.e. "tangential x" and "tangential y"). Normal loads
on horizontal planes are applied vertically downwards. The direction of normal loads on vertical
planes depends on the angle of rotation of the loaded plane as shown in figures below. Negative load
intensities can be specified to reverse their direction.

Vertical load on horizontal plane rotated in counter-clockwise direction 

Horizontal load on vertical plane rotated in counter-clockwise direction
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3.3.5.2 Circular

If the Mindlin analysis method is chosen then circular loads may be applied applied vertically and/or
horizontally on horizontal and vertical planes (i.e. in both the normal and horizontal directions).

If the Boussinesq analysis method is chosen then loads may be applied only vertically on horizontal
planes (i.e. in the normal direction).

Loads can be superimposed and placed at any level.  All loads are completely flexible - no allowance
is made for stiffness of the structures.

Note : The loaded areas can be entered in tabular form (as described below). Horizontal planes with
vertical circular loads, without any rotation can be entered in graphical form.  For information on entry
of graphical data see  Graphical Input.

Specification of the load in the table view. Much is context sensitive so its accessibility depends on
the load shape and orientation of the loaded plane

Orientation can be either horizontal or vertical.

Centre of load is the centre-point of the load for defining its plane entered in global co-ordinates.

Angle of local x w.r.t. global X orientates the local axis. The plane can be rotated (in plan) by an
angle. The base point for the rotation is the centre of the load. The figures below illustrate the local
axis in relation to the global axis.  Circular loads can also be rotated.  Although the shape then
remains the same, and normal loads are unaffected, the directions of tangential loads will be
affected.  The angle of local x w.r.t. global X is zero for loads parallel to the Cartesian co-ordinate
system.  Positive angles are counter-clockwise.

Radius is for circular loads only.

Number of rectangles It defines the number of rectangles that will be used to represent the circular
load for the purpose of calculation. An odd number must be specified.  A larger number will improve
the accuracy of the results close to the edge of the loaded area.

 
Representation of circular load by rectangles
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Load value specifies the load intensity to be applied to the plane.  Depending on the analysis
methods, loads can be either normal or tangential to the loading plane. Tangential loads are specified
with respect to the local axis of the loaded plane (i.e. "tangential x" and "tangential y"). Normal loads
on horizontal planes are applied vertically downwards. The direction of normal loads on vertical
planes depends on the angle of rotation of the loaded plane as shown in figures below. Negative load
intensities can be specified to reverse their direction.

Vertical load on horizontal plane rotated in counter-clockwise direction 

Horizontal load on vertical plane rotated in counter-clockwise direction
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3.3.5.3 Polygonal

For both the Mindlin and Boussineg methods polygonally shaped loads may be applied only
vertically on horizontal planes (i.e. in the normal direction).

If the Boussinesq analysis method is chosen then loads may be applied only vertically on horizontal
planes (i.e. in the normal direction).

Loads can be superimposed and placed at any level.  All loads are completely flexible - no allowance
is made for stiffness of the structures.

Specification of the load in the table view. Much is context sensitive so its accessibility depends on
the load shape and orientation of the loaded plane

Orientation can be either horizontal or vertical.

Angle of local x w.r.t. global X orientates the local axis. The plane can be rotated (in plan) by an
angle. The base point for the rotation is the centre of the load. The figures below illustrate the local
axis in relation to the global axis.  Although the shape then remains the same, and normal loads are
unaffected, the directions of tangential loads will be affected.  The angle of local x w.r.t. global X is
zero for loads parallel to the Cartesian co-ordinate system.  Positive angles are counter-clockwise.

The Coordinates of a polygonal load specify the vertices of the polygon, in the global X,Y plane
since polygonal loads may only be applied to horizontal surfaces. 

The Rectangle Tolerance of a polygonal load specifies the tolerance that will be used to fit
rectangles to the load's polygon.  For analysis the polygon is represented by a series of rectangular
loads. The rectangles that will be generated can be viewed, and the effect of adjusting tolerance
investigated, via the Polygon Wizard that is accessed by clicking the more button.

If more rectangles are required to represent a polygonal load then this can be achieved by altering
the Rectangle Tolerance. An illustration of the arrangement of rectangles that are used to
represent a polygonal load is available in the Polygon Wizard that is accessed by clicking the more
button.

Load value specifies the load intensity to be applied to the plane.  Depending on the load shape
and analysis methods, loads can be either normal or tangential to the loading plane. Tangential loads
are specified with respect to the local axis of the loaded plane (i.e. "tangential x" and "tangential y").
Normal loads on horizontal planes are applied vertically downwards. The direction of normal loads on
vertical planes depends on the angle of rotation of the loaded plane as shown in figures below.
Negative load intensities can be specified to reverse their direction.
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Vertical load on horizontal plane rotated in counter-clockwise direction 

Horizontal load on vertical plane rotated in counter-clockwise direction

3.3.6 Polygon Wizard

The Polygon Wizard is opened by clicking the "more" button in the Load Data table.  It allows editing
of a polygonal load's coordinates and its rectangle tolerance, together with the display of the
rectangles that will be generated for representation by rectangular loads during analysis.

The X and Y values are specified in global coordinates and define the vertices of the polygon upon
which the vertical (normal) load is to be applied. A polygon with duplicate vertices will only be
accepted if the duplicates are its start and end points. If the end point does not match the start point
then a closing edge will be assumed. 

A polygon with coordinates that define edges that cross each other will not be accepted.
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Coordinates may be pasted from a range in a spreadsheet by copying it from the spreadsheet to the
clipboard, then right-clicking in the top left cell of the coordinates to which that range is to be pasted,
and pressing <ctrl> + "v".

To delete coordinates click the row header number, and press <del>.

The Display check-box should be selected in order to display the polygon expanded to rectangles. 
Rectangles will only be generated for valid polygons. The coordinates may not be edited while the
rectangles are displayed. The Display check-box must first be de-selected.

In order to generate rectangles from a polygon the polygon is first expanded into trapezoids.  Each
trapezoid is then expanded into one or more rectangles. The rectangle Tolerance is defined as the
total "overlap" and "underlap" of rectangles within each trapezoid, as a proportion of the total area of
that trapezoid. It may be varied via the slider or via direct input to the edit box in order to vary the
accuracy of fit.  A lower tolerance will increase the accuracy of the fit but with the consequence that
analysis will take longer since more calculations will be required.  Due to the methodology used,
trapezoids with greater differences in length of their parallel edges will generate more rectangles than
those of lesser difference - even though those with lesser difference may have larger areas.  

Rectangles are recalculated immediately that the Tolerance is changed. Therefore, if using the edit
box to type a value, ensure that that value is always a valid number.  This can be done most easily
by highlighting the whole number to edit it, rather than by positioning the cursor precisely in the edit
box, which risks creating invalid numbers upon typing.

The procedure for generating rectangles considers every edge as a candidate at right angles to which
rectangles can be created.  Whichever edge would produce the fewest rectangles is then selected.
Hence, as the tolerance is varied the alignment of rectangles may change as well as their number,
as first one edge and then another becomes optimal. 

The minimum width of rectangle that will be produced is 50mm.  Trapezoids whose parallel sides are
less than that distance apart will be ignored, and those whose parallel sides are wider will be filled
with rectangles of width to suit the rectangle tolerance, or 50mm, whichever is smaller.  In this way
the creation of insignificantly narrow rectangles arising from rounding of coordinates by the user
(particularly for non-orthogonal edges) is avoided.

The definition of each rectangle that is generated can be viewed in the Text Output by selecting the
Polygonal Loads' Rectangles item in its wizard.

3.3.7 Soil Zones

The soil zones window allows the lateral limits, if any, of each soil profile to be specified.  This is
defined in terms of rectangular areas specified by corner x and y co-ordinates.  The soil zones are
therefore aligned with the Cartesian coordinate system.

Soil zone areas may overlap.  If this occurs then the profile relating to the soil zone with highest
allocated number will be used in the calculation.

If no soil zone is specified then the first soil profile is assumed to be widespread. Similarly, if
displacements are to be calculated for locations that are wide of any soil zones then the first soil
profile will be used.

The soil zones can be entered in either this tabular form or graphical form.  For information on entry
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of graphical data see Graphical Input.

3.3.8 Displacement Data

The points at which displacement results are required can be specified using grids, lines or individual
points. Results can also be given for the centre of each loaded area, see  Analysis Options.

The grids, lines or points can be entered in tabular form.

Any number of grids, lines or points can be entered.  

The following types of displacement data can be input.

Points
Lines
Grids

3.3.8.1 Points

Points are specified by single x, y and z co-ordinates.

Name is the name of the point.

X is the x coordinate of the point.

Y is the y coordinate of the point.

Z(level) is the level of the point.

Calculate specifies whether displacement calculations are to be performed for the point.

Detailed Results specifies whether the detailed results are to reported for the point

3.3.8.2 Lines

Lines can be entered in any orientation by specifying the co-ordinates at both ends.

Name is the name of the line.

Start and End points of the line are specified by entering their X, Y and Z (level) coordinates.

Intervals specify the number of intervals on the line.

Calculate specifies whether displacement calculations are to be performed for the line.

Detailed Results specifies whether the detailed results are to reported for the line.
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3.3.8.3 Grids

Grids can be entered horizontally,vertically or at an vertical inclination by extruding a line.  The
Direction of extrusion is specified as one of the Global axes (X, Y or Z).  A Line for extrusion must be
entered by specifying its end coordinates.   For example, if 'Global X' is the direction of extrusion
then the table allows the specification of a line in the YZ plane.

The extrusion depth should not be zero. Negative extrusion depth extrudes in the opposite to the
global directions.

The number of intervals is specified across and along the extrusion as shown below.

Calculate specifies whether displacement calculations are to be performed for the grid.

Detailed Results specifies whether the detailed results are to reported for the grid.
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3.3.9 Imported Displacements

Displacements from other programs may be imported from CSV files via 'File | Import |
Displacements...' from the program menu.  

The subsequent CSV Results Import dialog allows the choice of whether locations in the CSV file
that are duplicates of those already read are to be ignored. If the "Skip duplicate locations" option is
checked, then a tolerance may be specified which is used to determine whether two locations are
considered to be duplicates. The tolerance specifies the maximum distance within which locations
are deemed to be duplicates. If a point is found to be a duplicate of a location already read from the
CSV file, then it will be ignored, and only the first point and its results read into the model's data.

The purpose of Imported Displacements is to combine the displacements from other programs
together with those from Xdisp. The combined displacements may then be shown on the Text
Output, the Plan View or the 3D Graphical Output View.

The import file should include rows of data beginning with one of the following keywords.  Each row of
data contains displacement results for a single coordinate.

LOAD_RESULT
POI NT_RESULT
LPOI NT_RESULT
GPOI NT_RESULT
I NTERMEDI ATE_LOAD_RESULT
I NTERMEDI ATE_POI NT_RESULT
I NTERMEDI ATE_LPOI NT_RESULT
I NTERMEDI ATE_GPOI NT_RESULT

Whichever of these keywords is used, the data will be imported and treated in the same way. The
range of keywords is to allow the import of CSV files that have been exported from Xdisp or Oasys
Pdisp, which may contain any of these keywords.

Displacements follow the sequence: Keyword,x Coordinate,y Coordinate,z Coordinate,x
Displacement,y Displacement,z Displacement.

Units for data in the file are specified by the keywords UNI T_DI SP and UNI T_LENGTH
(displacement and length units respectively) followed by the index of the unit. Length and
displacement units' indices are: 0 - metres; 1 - centimetres; 2 - millimetres; 3 - feet; 4 - inches. 

Units information should appear in the file before the displacement results.

e.g.

UNI T_DI SP, 2
UNI T_LENGTH, 0
LOAD_RESULT, 0. 5, 43. 5, 0, - 0. 4967472, - 93. 72664, 47. 38838
I NTERMEDI ATE_LOAD_RESULT, 0. 5, 43. 5, - 2. 587683439, 0, 0, 38. 77201
I NTERMEDI ATE_LOAD_RESULT, 0. 5, 43. 5, - 4, 0, 0, 34. 85815
GPOI NT_RESULT, - 80, - 90, 0, 32. 98127, 27. 33411, - 0. 5642965
I NTERMEDI ATE_GPOI NT_RESULT, - 80, - 90, - 4, 0, 0, - 0. 5535589
I NTERMEDI ATE_GPOI NT_RESULT, - 80, - 90, - 6, 0, 0, - 0. 5062072
LPOI NT_RESULT, - 70, - 80, 0, 41. 05777, 32. 48021, - 6. 13E- 03
I NTERMEDI ATE_LPOI NT_RESULT, - 70, - 80, - 4, 0, 0, 3. 54E- 02
I NTERMEDI ATE_LPOI NT_RESULT, - 70, - 80, - 6, 0, 0, 0. 1545731
POI NT_RESULT, 0, 0, 0, 0. 7738549, - 31. 88898, 30. 52104
I NTERMEDI ATE_POI NT_RESULT, 0, 0, - 4, 0, 0, 26. 76711
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I NTERMEDI ATE_POI NT_RESULT, 0, 0, - 6, 0, 0, 23. 55008

If units are not specified in the file then a dialog will be shown at the beginning of the import process
for the user to specify the units of the data in the file.

These imported displacements may be viewed via 'Data | Imported Displacements...' from the
program menu or via the Gateway. Once imported they are non-editable. Imported displacements
can be deleted by right-clicking in the Imported Displacements Table View and selecting 'Delete All'
from the subsequent context menu.

In order that imported displacements may be combined sensibly with displacements that are
generated by Xdisp, the following rules apply.

1) All coordinates of data in the import file are imported whether a match is found for them or
not in the displacement grids, lines and points of the current Xdisp file.

2) The checking of whether coordinates match those of the displacement grids, lines and
points in the Xdisp file is performed at the time of analysis.   The tolerance for coincidence is
1 mm in all of the x, y and z directions. Those coordinates which match any in the Xdisp file
will have their results added to those of that Xdisp file after analysis.

3) If there are multiple entries of displacements for the same point in the import file, all those
displacements will be added to those calculated by Xdisp for the displacement position,
whether that position is modelled by Xdisp as a displacement point, or as a point within a
displacement line or grid.

4) Similarly, if one point in the import file is matched with more than one in the data file, e.g. if
displacement points, lines or grids contain coincident positions, then the imported
displacements will be added to each of the matching positions in the data file.

The diagram below illustrates a series of displacement coordinates in a CSV import file, a
Displacement Grid, a Displacement Line, and three Displacement Points in an Xdisp data file. It
shows how the results would be combined.

Coordinates such as 'A' are present in the CSV import file in one row of data only with one set of x, y
and z displacements.  Coordinates such as 'B' are present in the CSV file in two rows of data and so
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have two sets of x,y and z displacements.  Coordinates such  as 'C' are present only in the Xdisp
data file and not in the CSV import file.  Their results will therefore only reflect the results from
Xdisp's calculation of displacements.  Coordinates such as 'D' are present in the Xdisp data file, but
also in two rows of the CSV import file.  Their results will therefore be the sum of those from Xdisp's
calculation of displacements and the two rows of results in the CSV import file.  Coordinates such as
'E' are present in the Xdisp data file and in one row of the CSV import file.  Their results will therefore
be the sum of those from Xdisp's calculation of displacements and that one row of results in the CSV
import file. 

If an imported result is intended to be added to results at each displacement point in the Xdisp data
file, then care should be taken to ensure that the imported file contains one result for every data
point. When importing results from Oasys Pdisp this is most easily achieved by creating the same
set of Displacement Grids, Lines and Points in the two programs for export from one and import to
the other.  Having created the Displacement Grids, Lines and Points in one of the programs they can
be input to the other by copying and pasting between the programs' Displacement Data table views
by highlighting the required cells and via the right-click context menu options of 'Copy' and 'Paste'.
Note that the last columns in the Displacement Data for the two programs may display different data,
so only the first, common columns should be copied. 

Caution should be employed if results are inspected for which not all points of Displacement Grids,
Lines and Points have matching imported displacements.

The Text Output may be inspected for a summary of the displacements that have been imported and,
after analysis, those which have been found to match displacement points in the Xdisp file.

3.3.10 DXF Import of Background Data

The Background Data table can be accessed via 'Data | Background Data' from the program menu or
via the Gateway. It displays the DXF entities (LINES, POLYLINES, LWPOLYLINES and CIRCLES),
that have been imported from a DXF file by selecting File->Import->AutoCAD (DXF file)... from the
program menu. This data may then be displayed on the 3D Graphical Output view as a backdrop to
the model data.

The data may be manipulated by right-clicking in the table, or, in the case of the wizard, by double-
clicking in a cell. The subsequent context menu presents the following options.

Wizard displays a wizard dialog showing the DXF entity in more readable form. The Specification
field of the Background Data table gives the condensed information of DXF entities.  The wizard may
also be accessed by clicking on the wizard button present on the Pdisp Toolbar. 

Delete deletes a row of the table, i.e. one DXF entity. First select a row by clicking its row header
number.

Delete All deletes all rows of the table, i.e. all the DXF entities. The Background Data table will then
be removed from the Gateway.

Translate shifts all DXF entities by specified x, y and z distances. In this way the origin of the DXF
data can be moved to suit that of the Pdisp model.

Crop removes all DXF entities that lie either wholly outside, or partially outside a specified "box" of x,
y and z range.  If all DXF data has been imported with the same z level, then the cropping volume will
remove all data if its minimum and maximum z values are not changed from their defaults of the sole
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z level found in the data. 

Cropping allows the easy removal of rogue DXF data (e.g. from title blocks of drawings) that has been
imported inadvertently with coordinates far distant from the Pdisp model data. Such data may
otherwise make invisible the display of model data in the 3D Graphical Output.

All Background data can also be deleted via the 3D Graphical Output's context menu (i.e. by right-
clicking on the 3D Graphical Output view and selecting "Delete Background Data" from the
subsequent context menu).  Imported DXF background data in the 3D Graphical Output view can be
displayed or hidden via the Graphic Settings property sheet. 

A sample DXF file is supplied with the program.  See Sample Files for more information.

3.3.11 Non-linear Materials

The value of stiffness (Young's modulus E) with depth is specified in the Soil Profiles window.  For
linear materials each specified value of E will remain constant, at the given depth, throughout the
calculation for stress, strain and thereby displacement.

For models of  materials where the relationship between stress and strain is non-linear a non-linear
curve must also be specified.  This can be defined by the specification of a curve of strain versus
stiffness factor.

The curve is developed from the soil stress/strain relationship.

For increasing values of strain, the factor (F) by which Young's modulus is to be modified, is defined
by:

where L is the equivalent stress for a linear curve at a given strain ( ) and 
nl

 is the stress for the

non-linear curve.

All stresses referred to in this manual are stress changes due to the application of loads.  No
account is taken of stresses existing in the ground before loading.

Entering new data 
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To enter a new non-linear curve click on the Add Curve tab at the top of the grid.  This highlights the
Graph title box and provides the number of the next curve. If you then click the right button whilst still
on the tab the Page Edit Options screen will appear.  This allows the name of the curve to be altered
in addition to copying and deleting curves.

Non-linear curves can then be specified either in the table provided or by using the mouse cursor on
a pre-defined grid and clicking the left button to identify the required points.  

Strain can be entered on a linear or log scale.  The scales on the x and y axes can also be changed
clicking on the X max and Y max arrow keys in the view's status bar.

Editing data 

Points entered on the grid can be refined by editing the values displayed on the table.

Once the required curves have been entered then the user must return to the soil profile data
window.  The table now allows the appropriate curve to be allocated to the correct soil type.

3.3.12 Pile-Soil Interaction Using GsRaft

Pile-soil interaction properties can be entered only  if the "GSA raft  analysis  data"  option is  selected
in  the  Analysis  Options.  The  Oasys  GSA  program,  which  depends  on  Pdisp  application  data  for
GsRaft analyses,  uses these Pile-soil  interaction properties,  which provide additional information for
each soil stratum. The Pile-soil interaction properties do not affect the analyses or results of Pdisp. 

The facility can also be used to model interaction between soil and spread foundations.

The ground interacts with elements of the shaft of a pile in 3 dimensions (x, y, z) and in the vertical,
z, direction at the pile base.  In each case, the shape of the force-displacement curve for the
interaction is represented by /

ult
 = C( /D) for vertical displacement and C( /B) for horizontal

displacement, where:

 = interaction stress (shear or normal as relevant)

ult
 = maximum value of the stress

C() = a coefficient defined by a user-defined function (see Pile-soil interaction curves
C(..))

= displacement
D, B = geometry parameters defined as below.

The values of  represent the relative displacement between the pile and the elastic ground near it.
That is,  is the non-linear deformation of the soil local to the pile, which is usually behaving in a non-
linear manner.

For circular piles:

D  = diameter
B

x
 = B

y
 = D

For rectangular piles, Bx and By are the sides of the rectangle.
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p = 2B
x
 + 2B

y

D = p/

For H sections: 

Bx = flange width
By = web height + 2 x flange thickness
p = complete perimeter (roughly 2 x web height + 4 x flange)
D = (2B

x
 + 2B

y
)/

3.3.13 Pile-Soil Interaction Curves (PSICs) C(..)

The user is required to specify a number of shapes for the Pile-Soil Interaction Curves named PSIC1,
PSIC2 etc. 

For each PSIC, the coefficient C(d) is related to normalised relative displacement d (= /B or /D).  C
values for d beyond the range of values specified will be taken as 1.0 on the positive side and -1.0 on
the negative side.  

The scales on the x and y axes can also be changed by clicking on the x max and y max arrow
keys in the view's status bar. There is no limit for x max but 1.0 is the limit for y max.

The curve can be made symmetric about the origin by selecting the Symmetric check box for the
view's status bar. An asymmetric curve can be converted to a symmetric curve by choosing either to
use positive values to replace the negative values or vice-versa.

Pile-Soil Interaction Coefficients for lateral directions X and Y, vertical direction Z, and base, may be
derived by the user from p-y (lateral load - displacement), t-z (axial load - displacement) and q-z (tip
load - displacement) curves (tables and formulae) examples of which are given in section: References
- Pile-Soil Interation Curves.

3.3.14 Allocation of PSICs to Soil Strata

In each soil stratum, a Pile-Soil Interaction Curve (PSIC) is required for each dimension of
displacement of the shaft and for the vertical displacement of the base.  If there is no pile base in the
stratum, then the base data are ignored. The maximum stress in each mode of interaction is also
required.

3.3.15 Graphical Input

Graphical Input is accessed via the Data menu, the Gateway or the Pdisp Toolbar. The following data
can be entered in both tabular and graphical form.  The methods are fully interchangeable. 

Soil Zones

  Displacement Data

Load Data
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This section describes how to enter the data graphically.

Entering New Data 

1. Select 'Data->Graphical Input' from the program's menu.
2. Select 'Graphics->Input' from the program's menu or select the appropriate icon from the

Graphics Toolbar for soil zones , displacement data     or load data . These
buttons are context dependent. When the Graphical Input View is active they both display and
allow input of soil zones, displacement data and load data respectively. Subsequently deactivating
a button does not hide the entity.  Instead, when the Graphical Input View is active these entities
are hidden via 'Graphics -> Toggle items' from the program's menu. When the Plan View is active
these buttons allow display or hiding of soil zones, displacement data and load data respectively.

Once selected the cursor and left and right mouse buttons can then be used to enter the data.
Corresponding items can also be accessed via Graphics | Input from the program menu. 

3.3.15.1 Inserting Bitmaps

Bitmaps can be inserted behind the plan view.  If the site plan is available, at a suitable scale in
bitmap form, then this can be placed behind the input data to check locations of loads etc.  The
bitmap can be inserted in the following manner:

Select the bitmap button and open the required bitmap file.

This opens the Bitmap Scaling dialog.

Define the area required for the bitmap to cover in terms of maximum and minimum co-ordinates and
select "Load Bitmap".

The bitmap is then placed behind the main graphic in the Plan View.

Care should be taken not to copy large bitmaps, which can dramatically increase the size of the file.
 If the bitmap was used during data input it may be better to remove and store it separately from the 
Pdisp file.

3.3.15.2 Soil Zones - Graphical input

To enter the soil zones graphically; select the appropriate button for soil zones   from the 2D
Graphics Toolbar. Or select: Graphics | Input | Soil zones from the program's menu.

1. Place the cursor (cross) over the start of the area required.
2. Hold down the left button and drag the mouse until the full area is defined.

Once the area has been defined the screen will prompt for the entry of additional data. 

Enter the number of the appropriate soil zone and "Add to data".

This will also update the tabular input.  If the zone's area requires additional editing then this should
be carried out using the tables.
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3.3.15.3 Displacement Grids - Graphical input

To enter the displacement points, lines and grids graphically, select the appropriate button on the 2D

Graphics Toolbar      or select: Graphics ->Input ->Displacements -> Points (Lines or
Grids) from the program's menu.

1. Use the cursor (cross) to place the corner of a grid or at the start of the a line or point
location.

2. Left-click to place a displacement point, or hold down the left button and drag the mouse until
the full displacement grid's area or  displacement line's extent is defined .

Once defined the screen will prompt for the following additional information.

This will also update the Displacement Data table.  If the grid requires additional editing then this
should be carried out using that table.  

Once input of displacement points, lines or grids has been selected, the right mouse button may be
used to active a context menu from which the type of displacement entity for subsequent input may
be changed. 

Only horizontal lines and horizontal grids can be entered by Graphical Input. Others must be entered
in the Displacement Data table.

3.3.15.4 Load Data - Graphical input

To enter rectangular or cicrular load data graphically, select the load data button on the 2D Graphics

Toolbar . Or Select: Graphics ->Input ->Loads from the program's menu.

1. Use the right mouse button to activate the context menu from which to select the type of data
entry. 

2. Use the cursor (cross) to place the corner of a rectangular area or centre of a circle.
3. Hold down the left button and drag the mouse until the full area is defined.

Once defined the screen will prompt for the following additional information.

The number of rectangles is only required for the circular loaded areas, see Load Data.

This will also update the Load Data table.  If the area requires additional editing then this should be
carried out using that table.  

Only normal (vertical) loads on horizontal planes, with no rotation in plan can be entered by Graphical
Input. Others must be entered in  the Load Data table.
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4 Programming Interface

Programming interface is provided by COM Automation  in PDisp
 

COM Automation allows commands to be issued from a separate process via a set of VBA or C++
instructions. The separate process could be a separate program or, indeed, a VBA script in a
spreadsheet.
 

4.1 COM Automation

COM Automation allows other programs to access to PDisp operations by creating an instance of
PDisp class "pdispauto_19_4.Application" and calling the exported functions of this class. The
available COM export functions are listed below.
 

Note that function names are case sensitive.
 

More:
COM Export Functions
COM VBA Example
COM C++ Example

4.1.1 COM Export Functions

The PDisp COM export functions are listed below:
 

The return code (short data type) for all these functions is zero on successful execution, and -1 on
failure.

All the results obtained through the below mentioned functions are in SI units.

 

 short NewFile()
 

Open a new model. 
 

short Open (string filename)
 

Open a *.pdd file. 
 

filename – the name of the file to be opened, including path and extension.
 

short Save ()
 

Save the data to the default file (i.e. overwriting the file that was opened or last saved).
 

short SaveAs (string filename)
 

Save the data to*.pdd file. 
 

filename – the name of the file to be saved, including path and extension.
 

short Close ()
 

Close the current file.  
 

short Analyse ()
 

Analyse the current file.
 

short Delete ()
 

Deletes the results in the current file.
 

short Show ()
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Show the running instance of PDisp created by the Automation client. 
  

 

short AnalysisMethod (short* sMethod)
 

Gets the method of analysis. 
0 - Mindlin 
1 - Boussinesq 

 

short SetAnalysisMethod (short sMethod)
 

Sets the method of analysis. 
0 - Mindlin 
1 - Boussinesq 

short NumDisplacementData (short* sNumDispData)
 

Gets the number of displacement data entries in the current file. 
  

short NumRectLoads (short* sNumRectLoads)
 

Gets the number of rectangular loads in the current file. 

 

short NumCircLoads (short* sNumCircLoads)
 

Gets the number of circular loads in the current file. 

short NumPolyLoads (short* sNumPolyLoads)
 

Gets the number of polygonal loads in the current file. 

short NumDisplacementPoints (short* sNumDispPoints)
 

Gets the number of displacement points in the current file. 

short NumDisplacementLines (short* sNumDispLines)
 

Gets the number of displacement lines in the current file. 

short NumDisplacementGrids (short* sNumDispGrids)
 

Gets the number of displacement grids in the current file. 

short NumPointsAlongLine (short sIndex, short* sPoints)
 

Gets the number of points along the extrusion direction of the displacement line
identified with sIndex.

sIndex is a one based input.

short NumPointsAlongGrid (short sIndex, short* sPoints)
 

Gets the number of points along the extrusion direction of the displacement grid
identified with sIndex.

sIndex is a one based input.

   short NumPointsAcrossGrid (short sIndex, short* sPoints)
 

Gets the number of points across the extrusion direction of the displacement grid
identified with sIndex.
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sIndex is a one based input.

   short NumResults (short* sResults)
 

Gets the number of results. 

short NumPointResults (short sIndex, short* sResults)
 

Gets the number of results of the displacement point identified with sIndex. 

   short NumLineResults (short sIndex, short* sResults)
 

Gets the number of results of the displacement line identified with sIndex. 

   short NumGridResults (short sIndex, short* sResults)
 

Gets the number of results of the displacement grid identified with sIndex. 

         short GetDisplacementPoint(SHORT sIndex, DisplacementPoint* dispPoint)

      Gets the DisplacementPoint at sIndex.

      sIndex is a one based input.

         short GetDisplacementLine(SHORT sIndex, DisplacementLine* dispLine)

      Gets the DisplacementLine at sIndex.

      sIndex is a one based input.

         short GetDisplacementGrid(SHORT sIndex, DisplacementGrid* dispGrid)

      Gets the DisplacementGrid at sIndex.

      sIndex is a one based input.

         short SetDisplacementPoint(SHORT sIndex, DisplacementPoint* dispPoint)

      Sets the DisplacementPoint at sIndex.

      sIndex is a one based input.

         short SetDisplacementLine(SHORT sIndex, DisplacementLine* dispLine)

      Sets the DisplacementLine at sIndex.

      sIndex is a one based input.

         short SetDisplacementGrid(SHORT sIndex, DisplacementGrid* dispGrid)

      Sets the DisplacementGrid at sIndex.

      sIndex is a one based input.
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Below is the VB code that illustrates how the above displacement functions can be called

Dim pt As pdispauto_19_4.DisplacementPoint

sResult = PdispObj.GetDisplacementPoint(1, pt)

pt.Name = "Point1"

pt.X = 10

pt.Y = 10

pt.Z = 0

sResult = PdispObj.SetDisplacementPoint(1, pt)

Dim ln As pdispauto_19_4.DisplacementLine

sResult = PdispObj.GetDisplacementLine(1, ln)

ln.Name = "Line1"

ln.nIntervals = 10

sResult = PdispObj.SetDisplacementLine(1, ln)

         short GetRectLoad(SHORT sIndex, RectLoad* rectLoad)

      Gets the RectLoad at sIndex.

      sIndex is a one based input.

         short GetCircLoad(SHORT sIndex, CircLoad* circLoad)

      Gets the CircLoad at sIndex.

      sIndex is a one based input.

         short GetPolyLoad(SHORT sIndex, PolyLoad* polyLoad)

      Gets the PolyLoad at sIndex.

      sIndex is a one based input.

         short SetRectLoad(SHORT sIndex, RectLoad* rectLoad)

      Sets the RectLoad at sIndex.

      sIndex is a one based input.

          short SetCircLoad(SHORT sIndex, CircLoad* circLoad)

      Sets the CircLoad at sIndex.

      sIndex is a one based input.

          short SetPolyLoad(SHORT sIndex, PolyLoad* polyLoad)
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      Sets the PolyLoad at sIndex.

      sIndex is a one based input.

      sIndex is a one based input.

          short AddDisplacementPoint(DisplacementPoint* dispPoint)

      Adds the DisplacementPoint.

         Below is the VB code that illustrates how the above load functions can be called

Dim rl As pdispauto_19_4.RectLoad

sResult = PdispObj.GetRectLoad(1, rl)

rl.Name = "RectLoad1"

rl.Length = 10

rl.Orientation = Vertical

sResult = PdispObj.SetRectLoad(1, rl)

Dim cl As pdispauto_19_4.CircLoad

sResult = PdispObj.GetCircLoad(1, cl)

cl.Name = "CircLoad1"

cl.Normal = 100

cl.Orientation = Vertical

sResult = PdispObj.SetCircLoad(1, cl)

Dim pl As pdispauto_19_4.PolyLoad

sResult = PdispObj.GetPolyLoad(1, pl)

Dim pts(2) As pdispauto_19_4.Point2D

pts(0).X = -60

pts(0).Y = 60

pts(1).X = -60

pts(1).Y = 0

pts(2).X = -40

pts(2).Y = 60

p.Coor = pts

p.Name = "Polygonal Load"

sResult = PdispObj.SetPolyLoad(1, p)

 short AddDisplacementPoint(DisplacementPoint* dispPoint)
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      Adds the DisplacementPoint.

 short AddDisplacementLine(DisplacementLine* dispLine)

      Adds the DisplacementLine.

 short AddDisplacementGrid(DisplacementGrid* dispGrid)

      Adds the DisplacementGrid.

          short AddRectLoad(RectLoad* rectLoad)

      Adds the RectLoad.

 short AddCircLoad(CircLoad* circLoad)

      Adds the CircLoad.

 short AddPolyLoad(PolyLoad* polyLoad)

      Adds the PolyLoad.  

           short DeleteDisplacementPoint(SHORT sIndex)

      Deletes the DisplacementPoint at sIndex.

      sIndex is a one based input.

            short DeleteDisplacementLine(SHORT sIndex)

      Deletes the DisplacementLine at sIndex.

      sIndex is a one based input.

           short DeleteDisplacementGrid(SHORT sIndex)

      Deletes the DisplacementGrid at sIndex.

      sIndex is a one based input.

           short DeleteRectLoad(SHORT sIndex)

      Deletes the RectLoad at sIndex.

      sIndex is a one based input.

            short DeleteCircLoad(SHORT sIndex)

      Deletes the CircLoad at sIndex.

      sIndex is a one based input.

           short DeletePolyLoad(SHORT sIndex)

      Deletes the PolyLoad at sIndex.

      sIndex is a one based input.   
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           short GetBoussResult_RectLoad(SHORT sIndex, PdispBoussinesqResult* loadResult)

      Gets the PdispBoussinesqResult object for the rectangular load identified with sIndex.

                  sIndex is a one based input.

                  This function is to be called if the analysis method chosen is Boussinesq.

           short GetBoussResult_CircLoad(SHORT sIndex, PdispBoussinesqResult* loadResult)

      Gets the PdispBoussinesqResult object for the circular load identified with sIndex.

                  sIndex is a one based input.

                  This function is to be called if the analysis method chosen is Boussinesq.

           short GetBoussResult_PolyLoad(SHORT sIndex, PdispBoussinesqResult* loadResult)

      Gets the PdispBoussinesqResult object for the polygonal load identified with sIndex.

                  sIndex is a one based input.

                  This function is to be called if the analysis method chosen is Boussinesq.   

           short GetBoussResult_DispPoint(SHORT sIndex, PdispBoussinesqResult* dispResult)

      Gets the PdispBoussinesqResult object for the displacement point identified with
sIndex.

                  sIndex is a one based input.

                  This function is to be called if the analysis method chosen is Boussinesq.

           short GetMindlinResult_RectLoad(SHORT sIndex, PdispMindlinResult* loadResult)

      Gets the PdispMindlinResult object for the rectangular load identified with sIndex.

                  sIndex is a one based input.

                  This function is to be called if the analysis method chosen is Mindlin.

           short GetMindlinResult_CircLoad(SHORT sIndex, PdispMindlinResult* loadResult)

      Gets the PdispMindlinResult object for the circular load identified with sIndex.

                  sIndex is a one based input.

                  This function is to be called if the analysis method chosen is Mindlin.

           short GetMindlinResult_PolyLoad(SHORT sIndex, PdispMindlinResult* loadResult)

      Gets the PdispMindlinResult object for the polygonal load identified with sIndex.

                  sIndex is a one based input.
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                  This function is to be called if the analysis method chosen is Mindlin.   

           short GetMindlinResult_DispPoint(SHORT sIndex, PdispMindlinResult* dispResult)

      Gets the PdispMindlinResult object for the displacement point identified with sIndex.

                  sIndex is a one based input.

                  This function is to be called if the analysis method chosen is Mindlin.

           short GetBoussResults_RectLoad(SHORT sIndex,

SAFEARRAY(PdispBoussinesqResult)* loadResults)

      Gets the PdispBoussinesqResult object for the rectangular load identified with sIndex.

                  sIndex - index of the rectangular load. It is a one based input.

                  loadResults - SAFEARRAY of PdispBoussinesqResult objects for the rectangular load
identified with sIndex.

                  This function is to be called if the analysis method chosen is Boussinesq.

           short GetBoussResults_CircLoad(SHORT sIndex, SAFEARRAY(PdispBoussinesqResult)

* loadResults)

      Gets the PdispBoussinesqResult object for the circular load identified with sIndex.

                   sIndex - index of the circular load. It is a one based input.

                  loadResults - SAFEARRAY of PdispBoussinesqResult objects for the circular load
identified with sIndex.

                  This function is to be called if the analysis method chosen is Boussinesq.

           short GetBoussResults_PolyLoad(SHORT sIndex,

SAFEARRAY(PdispBoussinesqResult)* loadResults)

      Gets the PdispBoussinesqResult object for the polygonal load identified with sIndex.

                  sIndex - index of the polygonal load. It is a one based input.

                  loadResults - SAFEARRAY of PdispBoussinesqResult objects for the polygonal load
identified with sIndex.

                  This function is to be called if the analysis method chosen is Boussinesq.   

           short GetBoussResults_DispPoint(SHORT sIndex,

SAFEARRAY(PdispBoussinesqResult)* loadResults)

      Gets the PdispBoussinesqResult object for the displacement point identified with
sIndex.

                   sIndex - index of the displacement point. It is a one based input.
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                  loadResults - SAFEARRAY of PdispBoussinesqResult objects for the displacement
point identified with sIndex.

                  This function is to be called if the analysis method chosen is Boussinesq.

           short GetBoussResults_DispLine(SHORT sIndex, SAFEARRAY(PdispBoussinesqResult)

* loadResults)

      Gets the PdispBoussinesqResult object for the displacement line identified with sIndex.

                   sIndex - index of the displacement line. It is a one based input.

                  loadResults - SAFEARRAY of PdispBoussinesqResult objects for the displacement line
identified with sIndex.

                  This function is to be called if the analysis method chosen is Boussinesq.

           short GetBoussResults_DispGrid(SHORT sIndex, SAFEARRAY(PdispBoussinesqResult)

* loadResults)

      Gets the PdispBoussinesqResult object for the displacement grid identified with sIndex.

                   sIndex - index of the displacement grid. It is a one based input.

                  loadResults - SAFEARRAY of PdispBoussinesqResult objects for the displacement grid
identified with sIndex.

                  This function is to be called if the analysis method chosen is Boussinesq.

           short GetMindlinResults_RectLoad(SHORT sIndex,

SAFEARRAY(PdispBoussinesqResult)* loadResults)

      Gets the PdispMindlinResult object for the rectangular load identified with sIndex.

                  sIndex - index of the rectangular load. It is a one based input.

                  loadResults - SAFEARRAY of PdispMindlinResult objects for the rectangular load
identified with sIndex.

                  This function is to be called if the analysis method chosen is Mindlin.

           short GetMindlinResults_CircLoad(SHORT sIndex,

SAFEARRAY(PdispBoussinesqResult)* loadResults)

      Gets the PdispMindlinResult object for the circular load identified with sIndex.

                   sIndex - index of the circular load. It is a one based input.

                  loadResults - SAFEARRAY of PdispMindlinResult objects for the circular load identified
with sIndex.

                  This function is to be called if the analysis method chosen is Mindlin.

           short GetMindlinResults_PolyLoad(SHORT sIndex,
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SAFEARRAY(PdispBoussinesqResult)* loadResults)

      Gets the PdispMindlinResult object for the polygonal load identified with sIndex.

                  sIndex - index of the polygonal load. It is a one based input.

                  loadResults - SAFEARRAY of PdispMindlinResult objects for the polygonal load
identified with sIndex.

                  This function is to be called if the analysis method chosen is Mindlin.   

           short GetMindlinResults_DispPoint(SHORT sIndex,

SAFEARRAY(PdispBoussinesqResult)* loadResults)

      Gets the PdispMindlinResult object for the displacement point identified with sIndex.

                   sIndex - index of the displacement point. It is a one based input.

                  loadResults - SAFEARRAY of PdispMindlinResult objects for the displacement point
identified with sIndex.

                  This function is to be called if the analysis method chosen is Mindlin.

           short GetMindlinResults_DispLine(SHORT sIndex,

SAFEARRAY(PdispBoussinesqResult)* loadResults)

      Gets the PdispMindlinResult object for the displacement line identified with sIndex.

                   sIndex - index of the displacement line. It is a one based input.

                  loadResults - SAFEARRAY of PdispMindlinResult objects for the displacement line
identified with sIndex.

                  This function is to be called if the analysis method chosen is Mindlin.

           short GetMindlinResults_DispGrid(SHORT sIndex,

SAFEARRAY(PdispBoussinesqResult)* loadResults)

      Gets the PdispMindlinResult object for the displacement grid identified with sIndex.

                   sIndex - index of the displacement grid. It is a one based input.

                  loadResults - SAFEARRAY of PdispMindlinResult objects for the displacement grid
identified with sIndex.

                  This function is to be called if the analysis method chosen is Mindlin.
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4.1.2 COM VBA Example

The following is an example VBA script to run Pdisp remotely. This script can be found in the Excel
file in the Samples folder shipped with the program.
 

Sub TestPdispCOM()

Dim PdispObj

Set PdispObj = CreateObject("pdispauto_19_4.Application")

Dim PdispFilePath As String

Dim sResult As Integer

Dim rFileName As Range

    With Worksheets("Alp Auto")

        Set rFileName = .Cells(3, 3)

    End With

PdispFilePath = rFileName.Text

sResult = PdispObj.Open(PdispFilePath)

'Delete existing results

sResult = PdispObj.Delete()

Dim nDisps As Integer

sResult = PdispObj.NumDisplacementData(nDisps)

'Perform Analysis

sResult = PdispObj.Analyse()

'Save file

sResult = PdispObj.SaveAs(PDispFilePath)

sResult = PdispObj.Close()

Set PdispObj = Nothing

End Sub

4.1.3 COM C++ Example

The following is an example C++ code to run Pdisp remotely.

 

bool RunOneFunction(
COleDispatchDriver* pDispDriver,
CString csFuncName,
BYTE* pArgType,
CString csArgument,
SHORT* pShort)

{
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DISPID dispid;
OLECHAR* pcsFunc;
CString csMsg;
int iReturn(0);
pcsFunc = csFuncName.AllocSysString();

//Find the function ID
if(pDispDriver->m_lpDispatch->GetIDsOfNames(

IID_NULL,
&pcsFunc, 
1, 
NULL, 
&dispid) != S_OK)

{
csMsg.Format(_T("Function (%s) cannot be found"),csFuncName);
AfxMessageBox(csMsg);
return false;

}

//Run the function
if(csArgument.IsEmpty())

pDispDriver->InvokeHelper(
dispid,
DISPATCH_METHOD,
VT_I2,
&iReturn,
pArgType,
pShort);

else
pDispDriver->InvokeHelper(
dispid,
DISPATCH_METHOD,
VT_I2,
&iReturn,
pArgType,
csArgument,
pShort);

if(iReturn != 0)
return false;

else
return true;

}

void RunPdisp()
{

CoInitialize(NULL);

COleDispatchDriver cPdispDispDriver;

BYTE pArgType1[] = VTS_WBSTR VTS_PI2;
BYTE pArgType2[] = VTS_PI2;
CString csPath1("D:\\Tests\\PDisp\\Auto\\Test.pdd");//Replace this
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with the correct path and file location
CString csPath2("D:\\Tests\\PDisp\\Auto\\TestCopy2.pdd");//Replace

this with the correct path and file location

// Create an instance of the Alp class "Alp.Automation"
if(!cPdispDispDriver.CreateDispatch(_T("pdispauto_19_4.Application")))
{

AfxMessageBox(
_T("Pdisp not found or not registered"));

return;
}

bool bStat(true);
SHORT sRet;
// Function Open
if(bStat)

bStat = RunOneFunction(&cPdispDispDriver,
_T("Open"),
pArgType1,
csPath1, &sRet);

// Function Save
if(bStat)

bStat = RunOneFunction(&cPdispDispDriver,
_T("Save"),
pArgType2,
_T(""),
&sRet);

// Function SaveAs
if(bStat)

bStat = RunOneFunction(&cPdispDispDriver,
_T("SaveAs"),
pArgType1,
csPath2,
&sRet);

// Function Close
if(bStat)

bStat = RunOneFunction(&cPdispDispDriver,
_T("Close"),
pArgType2,
_T(""),
&sRet);

cAlpDispDriver.ReleaseDispatch();

CoUninitialize();
}
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4.1.4 Enums and Structs

Enum EOrientation

     HORIZONTAL
     VERTICAL

Enum EOrientation

X
      Y
      Z

Struct RectLoad

     BSTR  Name
     double X
     double Y
     double Z
     double Angle
     double Width
     double Length
     double Normal
     double TangentialX
     double TangentialY
     EOrientation Orientation

Struct CircLoad

     BSTR  Name
     double X
     double Y
     double Z
     double Angle
     double Width
     int nRectangles
     double Normal
     double TangentialX
     double TangentialY
     EOrientation Orientation

Struct Point2D

     double X
     double Y
     
Struct PolyLoad

     BSTR  Name
     double Level
     double Tolerance
     int nRectangles
     double Normal
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     SAFEARRAY(struct Point2D) Coor

Struct DisplacementPoint

     BSTR  Name
     double X
     double Y
     double Z

Struct DisplacementLine

     BSTR  Name
     double X1
     double Y1
     double Z1
     double X2
     double Y2
     double Z2
     int nIntervals

Struct DisplacementGrid

     BSTR  Name
     double X1
     double Y1
     double Z1
     double X2
     double Y2
     double Z2
     int nIntervalsAlong
     double ExtrusionDistance
     int nIntervalsAcross
     EExtrusion Extrusion

Struct PdispMindlinResult

     double X
     double Y
     double Z
     double DispX
     double DispY
     double DispZ

Struct PdispBoussinesqResult

     double X
     double Y
     double Z
     double DispZ
     double StressCalcLevel
     double Stress
     double SumPrincStress 
     double Strain
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5 Output

5.1 Analysis and Data Checking

Results can be obtained by selection of the Analysis menu:

Prior to analysis the program provides warning messages if applicable. 

Note: The option to 'Delete Results' becomes active once the calculations have been completed.

5.2 Text Output

Text Output is available from the View menu, the Gateway or the Pdisp Toolbar.  This output may
include input data and results - if an analysis has been performed. The results are provided in both a 
full and condensed tabular form. The lists of tabulated output can be highlighted and then copied to
the clipboard and pasted into most Windows type applications e.g. Word or Excel.  The output can
also be directly exported to various text or HTML formats by selecting Export from the File menu.

RESULTS FOR GRIDS

Analysis: Boussinesq

Global Poisson's ratio:  0.2

Rigid boundary level:   -30.0  

The maximum displacement difference between

Boussinesq method = 168.0mm and Mindlin method = 59.17mm

occurs at point X=16.00m Y=-39.00m Level -2.588mOD and is: 108.9mm

     Type                 Location            Displacement

                    X         Y     Z[Level]       X           Y         Z    

                   [m]       [m]      [mOD]       [mm]       [mm]      [mm]   

Loads        0.5000     43.50       0.0        105.8    -12.50     1.253

     1.000    -54.00    -2.000        117.1    -12.50     1.253

                      0.0    -6.000    -1.000        31.97    -12.50     1.253

Point 1               0.0       0.0    -10.00        34.90    -12.46     1.641

Point 2               0.0     4.000    -10.00        36.67    -14.46     2.539

Point 3               0.0     8.000    -10.00        38.23    -15.96     3.327

Point 4               0.0     12.00    -10.00        38.16    -16.61     3.676

Grid 1                0.0       0.0    -10.00        34.90    -12.46     1.641

                      0.0     4.000    -10.00        36.67    -14.46     2.539

                      0.0     8.000    -10.00        38.23    -15.96     3.327

                      0.0     12.00    -10.00        38.16    -16.61     3.676

                      0.0     16.00    -10.00        36.03    -16.25     3.668

                      0.0     20.00    -10.00        33.12    -15.14     3.799

                    4.000       0.0    -10.00        36.72    -10.72     2.827

                    4.000     4.000    -10.00        37.66    -12.84     4.777

                    4.000     8.000    -10.00        38.50    -14.13     6.645

                    4.000     12.00    -10.00        38.23    -14.67     7.302

                    4.000     16.00    -10.00        36.18    -14.84     6.865

                    4.000     20.00    -10.00        32.82    -14.52     6.859

An asterisk "*" at the right of a row indicates that the coordinate's result includes an imported
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displacement.

5.2.1 Full Text Output

The tabulated results listed below are available in the full output.

Type lists the type of location for the displacement co-ordinates, i.e. the centre of the loaded areas,
the points, lines and grids.

Location provides the global co-ordinates for the displacement points (X, Y, Z[level]) in metres.

Displacement calculation level provides the level of the grid and all intermediate displacement
levels

Displacement lists displacements at the displacement points and all intermediate displacement
levels.  Displacement in mm.   Positive displacement indicates settlement, negative indicates heave.

An asterisk "*" to the right of the 'Displacement' columns indicates that the coordinate's result
includes an imported displacement.

For the Boussinesq solution only, and if the point does not include the results of an imported
displacement:

Stresses list the stress values at all stress calculation points and at the centre of each sub-layer, as
defined by the intermediate displacement levels.

For consolidation problems, stresses are calculated and reported even at the displacement
calculation levels.

Once selected the program will scroll through all the results before allowing access to the data.

For Consolidation problems,

u is the excess pore pressure

U is the degree of consolidation

TimeStep : No is the number of time step at which the consolidation results are reported

TimeStep: Value is the consolidation time at which the results are reported

primary is the primary consolidation

secondary is the secondary consolidation

5.2.2 Condensed Text Output

The tabular results listed below are available in the condensed output.

Type describes the type of location for the displacement co-ordinates, i.e. the centre of the loaded
areas, the points, lines and grids.
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Location provides the global co-ordinates for the displacement points (X, Y and Z[level]).

Displacement lists displacement of the point resulting from the applied loading.  Horizontal
displacements are given in Global X, Y directions. Positive Z displacements indicate settlement,
negative Z displacements indicate heave.

An asterisk "*" to the right of the 'Displacement' columns indicates that the coordinate's result
includes an imported displacement.

5.3 Graphical Output

Graphical output is accessed via the View menu, the Gateway or the Pdisp Toolbar.

The graphics menu is available if any of the following windows is visible:
Plan
Cross section
Graphical Input

This menu allows the use of templates to save specific types of graphical displays.  It also allows the
user to display the load magnitudes, to annotate the grids, lines and points and to set an exact
scale for the display. 

Label objects is only available for the cross section view.

Input is only available for the Graphical Input view.

5.3.1 Templates

The templates function is used as follows.

1. Set up the graphics view which you would like to repeat for other files in the future.
2. Select the 'Save as template' option and save the view with a specific file name.
3. To reload the template select the 'Load template' option.
4. To return to the original view when the graphics option is opened select "reset defaults".

5.3.2 Plan View

Plots of the plan area of the problem can be created.

The graphical displays may be customised via menu commands or the following icons on the
toolbars.

Axis: Provides a reference grid behind the drawing.

  
Displacement Data (Grids, Lines and Points): All shown in as a grid or
using crosses to define individual points and points along lines. The plan
view shows only horizontal lines and horizontal grids. Inclined lines and
grids can be viewed on the 3D graphical output.

Imported Displacements: Plots the locations of imported displacement
points.
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Soil Zones: Plots the extent of the soil zones.

Loaded Areas: Plots the locations and sizes of the defined loaded areas. 
The plan view shows only normal (vertical) loads on horizontal planes, with
no rotation in plan.

  
Contours: The plan view shows contours (line contours or filled contours)
for only vertical displacements. Contours for horizontal, vertical and
resultant displacements can be viewed on 3D graphical output.

Inserting Bitmaps: Allows a bitmap to be placed behind the main
graphical view, see  Inserting Bitmaps.

Engineering Scale: This allows the user to toggle between the default
'best fit' scale and the closest available engineering scale. e.g. 1:200,
1:250, 1:500, 1:1000, 1:1250, 1:2500. 

Zoom: The user can select an area to 'zoom in' to by using the mouse to
click on a point on the drawing and then dragging the box outwards to
select the area to be viewed.  The program will automatically scale the new
view.  The original area can be restored by clicking on the 'restore zoom'
icon as shown here.

Save Metafile: Save icon allows the file to be save in the format of a
Windows Metafile.  This retains the viewed scale. The metafile can be
imported into other programs such as a word processor, spreadsheets and
drawing packages.

Copy: This icon allows the view to be copied to the clipboard in the form of
a Windows Metafile.

  
Change Displacement Grids: The user can move up or down to the data
defined for the different displacement grid levels.  The number of the level
currently being viewed is given at the top of the figure.

Annotation: Selection of this button allows the use of the mouse to place
the value of settlement at the exact location of the cursor and at the level of
the displacement grid selected.  Not the closest contour value.

To operate place the cursor over the required location and press return or
the left button on the mouse.

Tip: If a displacement line is in the vicinity of a point you wish to
annotate then de-select the displacement grids icon and proceed with the
annotation.  To get the maximum accuracy for the location of the points
maximise the size of the screen and scale of working.

Line Graph: Selection of this button allows the user to view a plot of
displacement (mm) versus distance along a defined displacement line by
clicking on it.

Custom Font: to specify a custom font scale to size text in the Plan View,
in the Input Graphics or when printing the Text Output (dependent on which
of those views is active).
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Quick Font: to select from a list of font scales to size text as above.

5.3.2.1 Set Contour Interval

Intervals for contours shown in the Plan View can be set by selecting from the program's menu:
Graphics -> Grid results -> Set contour interval. The Interval dialog box will appear.

5.3.2.2 Set Exact Scale

Selection of Set Exact Scale allows you to set any required scale for the graphics.  The chosen
scale will be maintained when the graphic is printed.  The scale is set via the Specify Scaling dialog.

5.3.2.3 Line Displacements

This provides a plot of displacement versus distance along the defined displacement lines.

To reach the plots click the "Line Graph" button, then place the cursor over the line you wish to view
and click with the left button.  The program then requests whether you wish to view the line number
available.

This view shows only horizontal lines. The deflected shapes of inclined lines can be viewed on the 3D
graphical output.

If 'No' is selected then the program will go to any lines below the area and ask again.  This allows
you to view lines which are superimposed at different levels.

5.3.2.4 Soil Column Displacements

This view provides the displacement profile along a vertical line under the user specified point.
Displacement is plotted against level or depth according to the user's choice.

To view the graph click the "Soil Column Displacements" item in the Gateway, or select "View | Soil
Column Displacements" on the program menu. A dialog box will pop up which asks for the plot data.

Enter the coordinates of the point under which the displacement profile is to be generated, and the
parameter against which displacement is to be plotted i.e. level or depth..

Press the "OK" button to view the graph.

The different soil layers of the zone in which the point lies are represented as coloured rectangles in
the graph.

The coordinates and the parameter against which the displacement should be plotted can be
changed via the dialog bar at the top of the view.

 Select the "Apply" button to view the graph.
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5.3.3 Cross Section Plot

This provides a plot of the generalised cross-section through the problem.

The section is not at any particular location and merely provides an illustration of the location of all
the input information which has both line and level.

5.3.3.1 Label objects

This option from the "Graphics" menu allows the user to label the Grids, Lines and Points with their
appropriate numbers and the Loads with their assigned values.

5.3.4 3D Graphical Output

The 3D Graphical Output displays a three dimensional plot of the model and its available results.

This entities and labels that are to be displaced are defined in the Graphic Settings property sheet 

The orientation of the model in the view is controlled via rotation, zooming and panning as described
below, and via buttons on the 3D Graphics toolbar which select the x, y or z elevation, perspective
mode and zooming to the extent of model data.

Rotate

The model can be rotated by pressing and holding the left mouse button and dragging the mouse. 
Horizontal drag rotates the model with respect to its Z axis.  Vertical drag rotates the model with
respect to the axis parallel to a horizontal line through the centre of the view.

Zoom

The model can be zoomed in or out by scrolling the mouse wheel.  The model can be zoomed to its
original scale by pressing 'z' from keyboard.

Pan

The model can be panned by holding 'shift + left-click' and dragging the mouse.  Panning is effective
for the orthogonal view.

Saving the view

The view point and zoom factor can be saved by selecting "Save default view settings" from the
context menu of the view.  The context menu is accessible by right-clicking in the view or by using
the context menu key on the keyboard).

Printing

The view can be printed.  The print may differ slightly from the image viewed on screen owing to
differing resolutions.
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5.3.4.1 Graphic Settings

The Graphic Settings property sheet allows the parameters that govern the format and content of 3D
Graphical Ourtput View to be specified.

These graphic settings are stored in the data file.  Default settings are provided by the program.  The
defaults can be restored by clicking the ‘Restore Defaults’ button.  The 'Apply' button applies the
settings to the 3D Graphics view.

This property sheet may be accessed via:
 

"Data | Graphic Settings" from the program's main menu; or

the Wizard button  on the Pdisp Toolbar when the 3D Graphics Output is active; or
selecting "Graphic settings" from the context menu of the 3D Graphics Output (the context menu
is accessible by right-clicking in the view or typing the context menu key from keyboard); or
the Gateway, by selecting "Output | 3D Graphics". 

The controls are separated into four different pages:

Soil
Loads
Displacements
Preferences

Each of these is described in detail below.

Soil zones and labelling

This section specifies which soil zones are to be displayed, and, if displayed, which should be
labelled.

Soil profiles

This section specifies how soil profiles are to be displayed.

Solid display
If this is selected soil profiles will be displayed as solid surfaces with their respective strata colours
as specified in the Soil Profiles table. Solid display does not allow the display of loads or
displacements.  

Wire frame display
If this is selected soil profiles are displayed as a wire frame. Wire frame display allows the display of
loads and displacements.

Soil zones display

This selection chooses which soil zones are to be displayed.  The list shows those soil zones that
have been defined in the Soil Zones table. It allows multi-selection.  

All
This button causes all the soil zones to be selected.

None
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This button clears the selection of soil zones.

Annotation
When this is checked all displayed zones are given labels on the 3D Graphics view.

Loads

This specifies which loads are to be displayed.

All the controls from this page are enabled only when the 'Wire frame display' button is selected in
the Soil page -> 'Soil profiles' section.

Loads and labelling

This section specifies which loads are to be displayed, and, if displayed, which should be labelled.

Load intensity can be viewed in two ways.
 
Loaded areas

Each different load intensity, as specified in the Load Data table, is displayed with a different colour.
 A legend of colour vs load intensity will be displayed. Load orientation i.e. normal, tangential x and
tangential y can be selected from the drop down list.

Loads as arrows

All loads associated with a loaded plane are viewed at once as arrows. The values of intensity will be
displayed at the tip of each arrow. Arrow size based on intensity allows the arrow length to be
scaled according to the size of the load. The scale can be doubled or halved by clicking the "x2" or
"/2" buttons.

Displacements

The Displacements' page specifies how the displacement input data and results are to be displayed.

The components of this page are enabled only when the 'Wire frame display' option is selected in the
'Soil profiles' section.

After performing an analysis, results are available for the Points, Lines and Grids specified in the 
Displacement Data table. The 3D Graphics View can illustrate these results. If no results are
available then only the undeflected locations of the proposed displacement data are available for
display. 

Displacement data and labelling

This section specifies which displacement entities are to be displayed, and, if displayed, which
should be labelled.

Grids
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Filled polygons

When this is checked the deflected nodes on a grid form a surface with filled polygons. When
unchecked it displays polygons by outlines.  This button is enabled only if results exist and when the
'Contour surface' button is unchecked. 

Contour surface

This selection allows display of line contours, filled contours or no contours.  Contours are displayed
with an interval specified in the 'Contour interval' edit box.  This represents the deflection pattern on a
grid.  This contour surface is drawn on an undeflected grid.  This is enabled only if results exist.

Contour interval

The value of the contour interval is automatically initialised with a default value based on the
minimum and maximum extents of the deflection results. The contour surface can be viewed at
another  contour interval by changing this value.   The minimum value that is required is such as to
limit the number of contours to less than 50.  The maximum value is the contour range.

Direction

The component of displacement in the X, Y and Z directions, or the resultant displacement, may be
chosen for display.  The contour surface or deflected shape will be based on this selection.

Display nodes

When this is checked the nodes on the grid will be highlighted with a small cube. This is helpful to
identify nodes on a deflected surface when the 'Filled polygons' button is unchecked.

Display values

When this is checked the nodes will be annotated with displacement values. This button is enabled
only if results exist. 

Undeflected/Deflected shape

When this is checked the undeflected positions of Points, Lines and Grids are displayed. This is
required to view the locations of displacement entities when there are no results.

General

Centre of rotation

This specifies the co-ordinate of the centre for rotating and zooming.

Centre of drawing

When this is selected the centre of rotation is set to the centre of the model, the resulting X and Y
co-ordinates are displayed in the edit boxes.  These cannot be edited directly. 

Custom
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When this is selected the edit boxes X and Y are enabled so that the centre of rotation may be
entered directly.

Labels

Name

Indicates that labels, where specified, are to display the names of entities only.

No.

Indicates that labels are to display the reference numbers of entities only.

No.:Name

Indicates that labels, where specified, are to display both the names and numbers of entities.

Transparent

When this is checked the surfaces become semi-transparent. The transparency depends on the
sequence of the drawing order.

Lighting

When this is checked light falls on the model from a pre-defined position set by the program. This
button is enabled only when lighting is appropriate.

Picture area to exclude legend panel

When this is checked the picture area used for the legend is used exclusively for the legend and that
used for the display of the image is reduced by the width of the legend panel.  Otherwise the legend
is superimposed on the image.

Perspective view

Toggles the view between orthogonal and perspective.

Defaults

This resets all the settings to the program's defaults and applies them to the 3D Graphics View.

OK

This applies to the 3D Graphics View the current settings from all the pages, and closes the property
sheet.

Undo

This undoes the changes to all those pages that have been modified since the 'Apply' button was last
pressed.



79Output

© Oasys Ltd. 2018

Apply

This applies to the 3D Graphics View the current settings from all the pages without exiting the
property sheet.

5.4 Chart Output

Chart outputs can be directly accessed from the output explorer.

Following are the chart outputs that the program provides:

1) Displacement vs Time

2) Displacement Lines
Settlement
Stress
Strain

3) Soil Column Displacements

5.4.1 Displacement vs Time

This is active only for consolidation problems. It shows the displacements at various time steps.

The user can select a particular displacement point or a point of any of the lines and grids by using
the drop lists provided.



80 PDisp Oasys Geo Suite for Windows

© Oasys Ltd. 2018

5.4.2 Displacement Lines

Following charts for can be viewed for displacement lines.

Settlement
Stress
Strain

5.4.2.1 Displacements

This provides a plot of displacements versus distance along the defined displacement lines.

The type of displacement (immediate or consolidation or total) can be selected from the drop down
provided. The time step at which the consolidation is to be viewed can also be selected from the drop
down provided,

5.4.2.2 Stress

This provides a plot of stress versus distance along the defined displacement lines. This is active
only for Boussinesq.
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5.4.2.3 Strain

This provides a plot of stress versus distance along the defined displacement lines. This is active
only for Boussinesq.

5.4.3 Soil Column Displacements

This view provides the displacement profile along a vertical line under the user specified point.
Displacement is plotted against level or depth according to the user's choice.
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5.5 CSV Results File

A comma-separated value (CSV) file of results may be output by selecting 'File | Export | CSV
Results File ..." on the program menu.  This option is disabled if there are no results, so an analysis
must have first been performed.  On selection of that option the CSV Results Export dialog will
appear.  This allows the specification of which results are to be written.

The CSV output file may contain any of the following:

 grid, line and point displacements;
 as appropriate to the analysis method, alignments of contours of displacements in the x, y, z or
resultant direction, and stresses (vertical and sum principal) and vertical strain.

One purpose of this output is to allow building damage segments/categories and displacement
contours to be plotted on drawings in other design programs e.g. AutoCAD.

In the case of displacement results, the CSV Results Export dialog allows the choice of whether
locations that are duplicates of those that have already been written are to be ignored. If the "Skip
duplicate locations" option is checked, then a tolerance may be specified which is used to determine
whether two locations are considered to be duplicates. The tolerance specifies the maximum
distance within which locations are deemed to be duplicates. If a point is found to be a duplicate of a
location already written written, then it will be ignored, and only the first location and its results
written.

For example, if Displacement Line 1 ends at coordinates (10,10,10), and Displacement Line 2 begins
at coordinates (10,10,10), then choosing "Skip duplicate locations" will ensure the location and
results at (10,10,10) are  written to the CSV file only once.

If a grid is selected for a direction that contains results that are all zero, then that direction will be
disabled for the export of contour results.

The output file includes keywords to identify the content of each row of data.  Samples are given
below which show the format. 

Grid, line and point displacements follow the sequence: Keyword,x Coordinate,y Coordinate,z
Coordinate,x Displacement,y Displacement,z Displacement.

Contour data lines follow the sequence: Keyword,Grid No.,Contour value,x Coordinate 1,y Coordinate
1,x Coordinate 2,y Coordinate 2.  They describe discrete segments of a contour line.

Dimensions for output data are chosen by the user in the "Save As" dialog that follows the "CSV
Results File Output Selection" dialog.  Length and displacement units' indices are: 0 - metres; 1 -
centimetres; 2 - millimetres; 3 - feet; 4 - inches.

Units information should appear in the file before the results.

e.g.

UNI T_DI SP, 2
UNI T_LENGTH, 0
CONTOUR_RESULTANT, 1, 10. , 30. , 22. 94968, 27. 96293, 23. 98147
CONTOUR_RESULTANT, 1, 10. , 27. 96293, 23. 98147, 26. 13617, 25.
CONTOUR_RESULTANT, 1, 10. , 26. 13617, 25. , 23. 26587, 26. 63294
. . .
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CONTOUR_X, 1, - 60. , 90. , 80. 55464, 89. 26049, 80. 36975
CONTOUR_X, 1, - 60. , 89. 26049, 80. 36975, 88. 89082, 80.
CONTOUR_X, 1, - 60. , 95. 56882, 75. , 91. 57434, 74. 21283
. . .
CONTOUR_Y, 1, - 60. , 48. 88889, 80. , 49. 25906, 79. 62953
CONTOUR_Y, 1, - 60. , 49. 25906, 79. 62953, 50. , 79. 4441
CONTOUR_Y, 1, - 60. , 49. 77666, 85. , 49. 81781, 84. 90891
. . .
CONTOUR_Z, 1, 0. , 50. , 0. 4412712, 48. 84946, 0. 5752676
CONTOUR_Z, 1, 0. , 48. 84946, 0. 5752676, 43. 20705, 0.
CONTOUR_Z, 1, 0. , 60. , 0. 3418683, 59. 22948, 0. 3852612
. . .
GPOI NT_RESULT, 150. , 240. , - 25. , 0. , 0. , - 1. e- 003
GPOI NT_RESULT, 150. , 250. , - 25. , 0. , 0. , - 1. e- 003
. . .
LPOI NT_RESULT, 50. , 150. , 0. , 0. 4636086, 0. , 0. 3708869
LPOI NT_RESULT, 51. , 150. , 0. , 0. 6526436, 0. , 0. 5438696
. . .
POI NT_RESULT, 5. , 150. , 0. , 0. 9029427, 0. , 0. 7851676
POI NT_RESULT, 55. , 150. , 0. , 1. 227543, 0. , 1. 115948

5.6 Old Data File Version

Pdisp files may be read by Oasys GSA in order to perform raft analysis.  However, GSA may not be
able to read Pdisp data files that have been written by the current version of Pdisp if this version of
Pdisp has been released after the current version of GSA.  In such situations it may be useful to
export Pdisp data files in the earlier format that can be read by GSA, although some data may then
be lost if recently added data cannot be converted to the earlier format.

To export a Pdisp data file in an earlier GSA-compatible format choose "File -> Export -> Old
Version..." from the program menu.

6 Miscellaneous

6.1 Keyboard Accelerators

Key Action

Ctrl+Num 1 Window bottom-left

Ctrl+Num 2 Window bottom

Ctrl+Num 3 Window bottom-right

Ctrl+Num 4 Window left

Ctrl+Num 5 Window middle (full)

Ctrl+Num 6 Window right

Ctrl+Num 7 Window top-left

Ctrl+Num 8 Window top

Ctrl+Num 9 Window top-right
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Ctrl+C Copy

Ctrl+F Find

Ctrl+G Go To

Ctrl+H Replace

Ctrl+M Modify

Ctrl+N New

Ctrl+O Open

Ctrl+P Print

Ctrl+S Save

Ctrl+Shft+S Save As

Ctrl+V Paste

Ctrl+W Wizard

Ctrl+X Cut

F1 Context Help

Esc Quit

Tab Next Cell

Return Next Cell

Insert Insert

Delete Delete

Home Beginning of Cell

Ctrl+Home Beginning of Table

End End of Cell

Ctrl+End End of Table

Page Up Scroll up

Page Down Scroll down

Row Up

Column Left

Column Right

Row Down

6.2 File Backups

A file backup results in a temporary copy of the model (input data and results) being saved in the
user's temporary folder (i.e. C:\Users\<username>\AppData\Local\Temp). 

Backups may be manual backups, timed backups, or backups before and after analysis.

Manual backups have "_M.xdd" appended to the file name. Timed backups and backups before and
after analysis have "_bak" appended to the file name.

A manual backup of the data file is created automatically on opening a file. 
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A timed backup of the model is created periodically according to the user's preferences for timed
backups.  Those preferences are reached via Tools -> Preferences from the program menu, where
the option to save timed backups may be set along with a backup interval.

A backup is also made automatically on beginning an analysis (so with no results) and on
completion of a successful analysis (so with results).

If a model has results then no timed backup is made since, if the file is unchanged since opening
there is no need, and if the file has been changed then an analysis must have been performed to
create those results, so a backup will have already been created on completion of the analysis.

If the program shuts down prematurely (as a result of program malfunction or power failure etc.) then
the backup files remain on disk for subsequent use if recent changes were not saved by the user and
so have otherwise been lost. The user may delete such backup files manually from their temporary
folder when they are no longer needed. They will, however, be overwritten if a data file with the same
name is opened, so their previous contents will be lost. 

All instances of a model's backup files are automatically deleted when the data file is closed
properly.
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8 Brief Technical Description

8.1 PDisp

PDisp Pressure Induced Displacement Analysis

PDisp is a program which can calculate the displacements (and stresses if required) within a linear
elastic or non-linear soil mass, arising from uniform  normal or tangential pressure, applied to
rectangular and circular loaded planes.

The ground is represented as a series of soil profiles.  These are located in plan by using designated
areas known as soil zones.

Loads are completely flexible. Pressures are applied as vertically and/or horizontally and uniformly
distributed loads to rectangular and/or circular loaded areas. No allowance is made for the stiffness
of the structures.

Displacements can be calculated both beneath and adjacent to the applied loads. Horizontal and
vertical displacements can be calculated by choosing the Mindlin method. Vertical displacements
and stresses can be calculated by choosing Boussinesq method.

Vertical displacements (settlement and heave) are calculated relative to a rigid base, using one of
two approaches: Boussinesq and Mindlin.

In the Boussinesq method the stress distribution is correct for a uniform isotropic, elastic material
having a constant Poisson's ratio (which must be specified).  Vertical strains are derived from this
stress distribution using the elastic constants appropriate to that strain level for each soil layer and
then summed to give displacements.

In the Mindlin method relative displacements across each soil layer are calculated directly as if the
whole of the ground had the same elastic properties as the layer concerned.  The relative
displacements are then summed to give total displacements.

The Mindlin approach is more accurate, but the Boussinesq method allows non-linear soil properties
and is relatively accurate if sufficient sub-layers (intermediate displacement levels) are used.

The sides of all soil zones are parallel to the Cartesian co-ordinate axes.
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9 Manual Example

9.1 General

The data input and results for the PDisp manual are available in the 'Samples' sub-folder of the
program installation folder.  The example has been created to show the data input for all aspects of
the program and does not seek to provide any indication of engineering advice.

Screen captures from this example have also been used throughout this document.

This example can be used by new users to practise data entry and become familiar with the details
of the program.
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